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QuICk START Y APPLICATION NOTES

QuICk START

ATENCIóN: 
El presente documento Quick Start (Guía Rápida):
• se ha concebido para proyectistas y desarrolladores y presupone el conocimiento de uno o varios lenguajes estándar de 

programación iEC61131-3. 
• se ha realizado para proporcionar una panoramica de primer nivel de la instalación, funciones y utilización de la suite 

FREE Studio
• presupone la lectura del manual de instalación FREE Smart cod. 9MAx00036 y/o del manual de instalación FREE Panel 

cod. 9MAx00046 y/o del manual FREE Evolution cod. 9MAx00042 (x = 0: it; 1: EN; 2: FR; 3: ES; 5: DE) disponible solo 
en formato electrónico (pdf) en nuestra web www.eliwell.it previo registro en el Área reservada.

• está disponible solo en formato electrónico (pdf) en nuestra web www.eliwell.it previo registro en el Área reservada

APPLICATION NOTES

Eliwell proporciona documentación adicional en forma de Application Notes 
Un Application Notes  ofrece detalles más específi cos sobre el uso de un componente en una específi ca aplicación o sobre 
un proceso particular, por ejemplo, el ensamblaje físico de un producto que contenga el componente.
 
las notas aplicativas son especialmente útiles para delucidar los usos más insólitos de un componentes específi co, que sería 
irrelevante para muchos lectores (instrucciones, manual de usuario, instalación o quick Start).

MFk
• Smart

FILE SYSTEM uSB
• Evolution

wEB SERvER
• Evolution

PROFIBuS DPv0
• Evolution

REMOTE CONNECTION
• Evolution

MODBuS MASTER
• Smart
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INTRODuCCIóN

DESCRIPCIóN GENERAL
la herramienta de desarrollo FREE Studio permite realizar y personalizar de 
modo rápido y eficaz nuevos programas para cada tipo de aplicación iEC, en 
particular para las necesidades del sector HVAC/R. 
El uso de varios lenguajes de programación según las normativas  
IEC61131-3 (estándar de programación para el control industrial), le permite 
la posibilidad de desarrollar nuevos algoritmos o programas completos con 
total autonomía, que se descargan a los módulos 
• FREE Smart mediante PC o Multi Function key 
• FREE Evolution mediante PC o USB 
garantizando al máximo su confidencialidad mediante las debidas proteccio-
nes. 

COMPONENTES 
A continuación se repasan todos los componentes básicos, interfaces, convertidores y accesorios[1].

Software FREE Studio
la suite de software FREE Studio[2]  y sus funciones se exponen en el presente documento. 
la suite de software FREE Studio se compone de 5 entornos de desarrollo necesarios para la programación de los controles 
programables FREE Smart, FREE Panel & FREE Evolution:
• FREE Studio Application, específico para los desarrolladores, para la creación / gestión de librerías y aplicaciones iEC y 

diagnósticos.
• FREE Studio Device, diseñada para los usuarios, para la gestión de aplicaciones iEC anteriormente desarrolladas, la 

descarga de las mismas al dispositivo target[3] y la modificación de los parámetros del instrumento desde serial.
• FREE Studio Simulation, específico para desarrolladores, para la ejecución de aplicaciones PLC y páginas hMI (solo 

Evolution) en un entorno de simulación sin necesidad de disponer de un dispositivo target[4]

los siguientes 2 entornos de desarrollo se hallan disponibles solo para FREE Evolution:
• FREE Studio Connection[5], específico para desarrolladores, para la configuración de redes
• FREE Studio user Interface, específico para desarrolladores, para la personalización de la interfaz gráfica de los termina-

les 'built-in' y de los demás terminales.

DM Interface (DMI)
Componente necesario solo para FREE Smart:
Componente necesario para conexión a PC
la interfaz de hardware USB/ttl-i2C DMi, que se utiliza asociada a la suite de software permite:
• El uso del software mismo.
• Conectarse al dispositivo target para su gestión.
• Conectarse al componente  Multi Function Key (MFk).

Multi Function key (MFk)
Componente necesario solo para FREE Smart:
Soporte de memoria que permite:
1. Actualizar el firmware del dispositivo target. 
2. Actualizar la aplicación IEC del dispositivo target. 
3. Actualizar los valores de los parámetros del dispositivo target.
4. Descargar del dispositivo target los valores de los parámetros.

Cables de conexión
Componentes necesarios solo para FREE Smart:
• Cable de color “amarillo” con terminaciones jSt – molex, para su uso ver cap. Modalidad de conexión 
• Cable de color “azul” con terminaciones jSt – jSt , para su uso ver cap. Modalidad de conexión
• Cable de prolongación USB-A/A de 2 m.

Convertidores
Componentes necesarios solo para FREE Evolution:
• adaptador USB/485 
• adaptador USB/CAN

1 Las interfaces y los convertidores se utilizan con Smart o Evolution.
2 Suite o paquete de software. ver Abreviaciones y definiciones
3 Control programable. ver Abreviaciones y definiciones
4 Sin la necesidad de disponder de un Smart o Evolution físico se puede descargar una aplicación IEC directamente al Simulador.
5 Solo para Evolution: Connection es 'el punto de partida' de la Suite software - ver capítulo Target

IEC 61131-3
development
environment
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Nota: como alternativa, si dispone de un puerto RS232 se puede conectar Evolution al PC mediante un adaptador RS485/
RS232

Plug-in (Evolution)
Una amplia gamma de módulos plug-in con montaje 2DiN permite su integración en sistemas industriales y BMS y redes 
ethernet.
Nota. no disponibles para FREE Panel, que dispone de 3 seriales RS485, CAN y EtHERNEt a bordo.

Abreviaciones y definiciones
• Application, Device, Connection, Simulation, userInterface: abreviaciones de FREE (Studio) Application, FREE 

Device, FREE Connection, FREE Simulation y FREE userInterface respectivamente. Suite de Software.
• Aplicación IEC, Aplicación PLC, PLC: aplicación realizada según normativas IEC61131-3 (estándar de programación 

para el control industrial) mediante el entorno (tool) de desarrollo Application que se descarga en el target mediante 
Application o Device

• dispositivo Target, Target: nombre que se le da al control programable FREE Smart, FREE Evolution o FREE Panel /
(EvP), es decir el “instrumento”

• DMI: abreviación de DM interface
• hMI: acrónimo de human Machine Interface. interfaz gráfica desarrollada con userInterface
• Instancia: objeto de una 'clase' de objetos predefinida (bloque de función, plantilla, etc)
• Lenguaje IEC: lenguaje de programación según la normativa IEC61131-3 
• Menú BIOS, BIOS: menú de parámetros BiOS pre-configurado en fábrica. No es modificable[6]

• MFk: abreviación de Multi Function Key
• Quick Start: el presente documento
• Smart: abreviación de FREE Smart; Evolution: abreviación de FREE Evolution; EvP: abreviación de FREE Panel
• Studio: abreviación de FREE Studio. Suite de Software descrita en el presente documento.
• Tab o pestaña. El entorno de trabajo se halla dividido en secciones o paneles. Cada panel puede ser subdividido a su 

vez en pestañas o tabs (ej. tab Resources)
• Template: en el presente documento se entiende que es la plantilla de una página realizada con userInterface
• Panel o sección: ver Tab (ej. panel Project)
Nota: Muchas definiciones o abreviaciones son estándar del lenguaje informática y/o PlC y no aparecen en este listado
Por ejemplo una Función es un término estándar. Otros términos, como Bloque Función sse describirán en sus correspon-
dientes apartados.

RECuRSOS DE SISTEMA
El desarrollador dispone de los siguientes recursos disponibles en los target para la programación iEC

Smart (°) Evolution
CPu 14.7 MHz 72 MHz, 32MB RAM
memoria disponible 
para Application 190KByte 1.5MByte

memoria disponible 
para user Interface - 1.5MByte

memoria FlASH datos - 126MByte
memoria RAM* 2300Byte 512KByte
memoria RAM** 1024Byte 5000 word
variables EEPROM 1024Byte 4000 word
* mapeado automático  
** mapeado Modbus

(°) Modelos /C/S 
msk 412

6 La BIOS no es modificable pero puede actualizarse. 



FREE Studio - Quick Start  pág. 4

REQuISITOS MÍNIMOS DE SISTEMA

SISTEMAS OPERATIvOS

• Windows xP Home SP2 o SP3 italiano, inglés, español y alemán.
• Windows xP Professional SP2 o SP3 italiano, inglés, español y alemán.
• Windows 7 Home Premium italiano, inglés, español y alemán.
• Windows 7 Professional italiano, inglés, español y alemán.
• Windows 7 Ultimate italiano, inglés, español y alemán[1].

OTROS SOFTwARE
(solo FREE Smart)
Driver At90USBxxx CDC USB to UARt MgM para la utilización de la interfaz DMi[2]

Ver capítulo instalación interfaz DMi

hARDwARE MÍNIMO

• Resolución gráfica 1024x768
• CPU 700MHz
• RAM 1gB
• HD 5gB de espacio libre en disco
• 1 puerto USB[3]

• Ratón o sistema puntero equivalente.
• 1 lector CD-RW

Nota. la instalación tipica (que se halla disponible en idioma inglés, librerías estándar) requiere unos 500 Mbyte de espacio en 
disco.  Se necesita un 1gByte de espacio libre adicional en disco para la instalación de las librerías y aplicaciones específicas.

Para la descarga de la aplicación se necesitan los siguientes componentes:

hARDwARE FREE SMART Y ACCESORIOS

• 1 FREE Smart SMD5500/C/S o un dispositivo target de la familia FREE Smart
• 1 DMI 100-3 Manufacturer + cable amarillo ttl[4]

• 1 MFk opcional + cable azul ttl 
• cableado para alimentación FREE Smart[5]

hARDwARE FREE EvOLuTION Y ACCESORIOS

• 1 FREE Evolution EvD7500/u o pedir el maletín simulador para demostraciones (Demo Case)
• 1 convertidor uSB/RS485 o uSB/CANOpen o plug-in Ethernet 
• transformador 35vA para alimentación FREE Evolution

INTERNET

El Setup de instalación se suministra en CD-RW.
El Setup de instalación, la actualización de software, librerías y documentación también se encuentran disponibles en el sitio 
www.eliwell.it previo registro en el Área Reservada (ver capítulo Soporte tecnico).
Compruebe la disponibilidad de la conexión a internet para el acceso al software y manuales.

1 Para todos: otros idiomas no han sido explícitamente testados.
2 Disponible en el paquete de instalación.
3 Para Evolution también se puede utilizar un puerto RS232 mediante el convertidor RS232/RS485. 
 Para Smart (solo versiones /S) se puede utilizar el puerto RS232 mediante el convertidor RS232/RS485 con velocidad máxima 19200 baudios.  
 TTL en este caso no es utilizable.
4 ver capítulo Modalidad de conexión
5 No es necesario alimentar FREE Smart si está conectado al PC mediante DMI. utilice cable TTL amarillo.
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INSTALACIóN

INSTALACIóN FREE STuDIO 

Ejecute EliwellFREEStudio_xxx.exe[1] suministrado por Eliwell y a continuación proceda con el asistente de instalación (en 
inglés) tal como se indica en las pantallas siguientes.

1. Haga click en ‘Next’
2. Haga click en ‘I accept the agreement’[2] es decir acepte las condiciones de uso para la licencia del software
3. Haga click en ‘Next’. Al finalizar la instalación aparecerá el icono FREE Studio en el Escritorio. 

1 2 3

4. Haga click en ‘Install’.
5. instalación en progreso
6. Haga click en ‘Finish’.

4 5 6

ICONOS APLICACIONES
Haga click en el icono FREE Studio del Escritorio; se accederá a una carpeta con los siguientes links.
 

Smart 
Evolution Evolution

Iconos

(link)
Descripción

Iconos

(link)
Descripción

 

herramienta desarrollo
Application

para Smart & Evolution

herramienta desarrollo
Connection

para Evolution

herramienta desarrollo
Device

para Smart & Evolution

herramienta desarrollo
user Interface

para  Evolution

herramienta desarrollo
Simulation

para Smart & Evolution

1 Comprobar como precaución la versión de software con el Soporte Técnico de Eliwell
2  Para proseguir con la instalación es obligatorio aceptar la licencia de uso.   
 Lea atentamente las condiciones de uso descritas (End user License Agreement 'EuLA') antes de continuar.
 Las condiciones de uso también están disponibles en nuestra web  en la dirección http://www.eliwell.it/content.aspx?id=4533

http://www.eliwell.it/content.aspx?id=4533
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TARGET
la Suite de software Studio ha sido diseñada para su utilización con los target Smart, Panel y Evolution
la selección del dispositivo target adecuado para las necesidades del desarrollador se indican el capítulo Defi nición de Re-
quisitos hardware

FREE wAY
la Suite de software Studio es una sola para  Smart, Panel y Evolution.
El sistema conjunto se denomina FREE way: el software FREE Studio + el hardware FREE Smart, Evolution y Panel

FREE SMART
El desarrollador de Smart tiene a su disposición solo los entornos de trabajo Application y Device[1] 
El desarrollador de Smart para empezar a programar puede lanzar Application.  
El usuario de Smart para descargar la aplicación iEC anteriormente compilada por el desarrollador podrá utilizar Device.
Desde Application siempre puede abrir directamente Device sin tener que lanzar el programa con el icono FREE Studio.

FREE EvOLuTION
El desarrollador de Evolution tiene a su disposición todos  los entornos de trabajo.
El desarrollador de Evolution para empezar puede lanzar Connection. Connection es el punto de partida para todas las activi-
dades de desarrollo, desde la programación PlC , a la creación del menú HMi hasta la descarga en el target mediante Device.
Desde Connection  siempre puede abrir directamente tanto user Interface como Application y Device sin tener que lanzar su 
correspondiente programa mediante el icono FREE Studio.

FREE PANEL
El desarrollador de Panel tiene a su disposición todos  los entornos de trabajo[2].
El desarrollador de Panel  para iniciar podrá lanzar Connection. Connection es el punto de partida para todas las actividades 
de desarrollo, desde la programación PlC , a la creación del menú HMi hasta la descarga en el target mediante Device. Desde 
Connection  siempre puede abrir directamente tanto user Interface como Application y Device sin tener que lanzar su corre-
spondiente programa mediante el icono FREE Studio.

1 Incluyendo Simulation
2 Excluyendo Simulation

Smart Panel EvolutionEvolution
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INSTALACIóN DM INTERFACE (DMI)[1]

CONEXIóN DE LA INTERFAz DMI AL PC
Conecte la interfaz DMi a uno de los puertos USB del PC. 
Para facilitar la conexión de la interfaz le aconsejamos que use el alargador USB suministrado.

SETuP INTERFAz DMI
El sistema operativo Windows xP®[2] en el momento de la conexión de la interfaz DMi pone en marcha un procedimiento guia-
do para su instalación. A continuación le indicamos los pasos a seguir.

1. En la pantalla de arranque seleccione la opción “No, no ahora” y pulse “Siguiente".
2. Configure la segunda opción, como se indica, y pulse “Siguiente”. 

El itinerario que se ha de especificar es el del directorio de instalación del programa.
3. Pulse ‘Siguiente’  y/o busque con ‘Examinar’ el itinerario indicado. 

1 2 3

4. El sistema operativo le pedirá la confirmación de la instalación de los drivers. 
Pulse “Continuar”[3].

5. Cuando el sistema operativo reconozca el dispositivo (driver) como “At90USBxxx CDC USB to UARt MgM[4]”, pulse “Fin”.

4 5

1 Esta operación se realiza tras la instalación de Studio. Instalación necesaria exclusivamente para Smart
2 Para el S.O. win 7 la instalación se describe más adelante 
3 Ignore el mensaje de advertencia sobre compatibilidad con windows XP
4 El fichero at90usbxxx_cdc.inf que contiene el driver se coloca en la carpeta C:\Program Files\Eliwell\FREE Studio
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Lectura del puerto COM de la interfaz DMI
Siga los pasos que le indicamos para controlar qué puerto COM ha asignado el sistema operativo a la interfaz DMi.

1. Pulse con la tecla derecha del ratón sobre el icono “Propiedades del Sistema”.
2. En el menú contextual seleccione “Hardware”.
3. En la ventana de la izquierda haga click en “Administrador de Dispositivos”.
4. En la ventana de derecha abra el desplegable “Puertos (COM y lPt)”.
5. lea el valor del puerto al final de la secuencia “At90USBxxx CDC USB to UARt MgM” o en todo caso de la secuencia que 

contiene los datos de la interfaz DMi.
6. En el ejemplo de la figura el valor es:  COM 3.

Modificación de la Configuración del puerto COM
En caso de conflictos o de necesidad se puede asignar otro puerto a la interfaz tal como se indica en la figura siguiente.
• 1. tecla derecha del ratón sobre el puerto COM examinado.
• 2. Pulse en “Propiedades".
• 3. Seleccione la pestaña Configuraciones del puerto.
• 4. Pulse en la tecla Avanzadas.
• 5. Modifique el número del puerto COM al valor deseado.
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SETuP INTERFAz DMI wIN 7
El sistema operativo Windows 7 en el momento de la conexión reconoce el nuevo hardware conectado.

A continuación les mostramos los pasos a seguir.
1. Una vez conectado el hardware aparecerá la indicación que se muestra en la figura:

Clique a continuación sobre el mensaje para dar inicio al procedimiento de instalación guiada.
2. Aparecerá la siguiente pantalla, donde puede seleccionar la segunda opción para identificar el driver.

3. En la siguiente pantalla, seleccione el itinerario de instalación del programa FREE Studio. Si no se ha cambiado durante la 
instalación el itinerario será el que aaprece en la figura.

4. Una vez seleccionado el itinerario correcto se visualizará la siguiente pantalla, donde puede seleccionar el mensaje "instalar 
de todos modos el driver" Install this driver software anyway

 
 

win 7 32bit:
C:\Program Files\Eliwell\free Studio 
win 7 64bit:
C:\Program Files (x86)\Eliwell\free Studio
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5. A continuación aparecerá la siguiente pantalla, indicando que se está ejecutando la acción.

6. Al finalizar el proceso se visualizará la siguiente pantalla

 

Para comprobar la correcta instalación del driver y el puerto al que se ha asignado el hardware compruebe la siguiente pantalla 
de Windows.
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DEFINICIóN REQuISITOS hARDwARE

PEQuEñAS APLICACIONES

FREE Smart ha sido diseñado para instalaciones de pequeñas dimensiones y en particular para: 

Constructores de:
• U.t.A. (Unidades tratamiento Aire)
• Chiller & Bombas de Calor
• Rooftop
• Centrales Compresores  

Instaladores/integradores de:
• instalaciones de aire
• instalaciones hidrónicas
• instalaciones mixtas (aire/acqua)

CRITERIO SELECCIóN FREE SMART
los modelos FREE Smart se encuentran disponibles tanto en su versión para montaje en guía DiN, que permite un notable 
ahorro en el tiempo de cableado, como en el conocido formato 32x74 de Eliwell para su montaje en panel.

 FREE Smart SMP presenta 2 modelos en función de las que podemos de 6 entradas digitales, 
 hasta 5 salidas en relé, hasta una salida tRiAC, 2 salidas analógicas PWM, 3 salidas analógicas 0…10V/0… 
 20mA/4…20mA confi gurabbles y una salida digital Open Collector para relé externo. 
 El formato 32x74mm estándar de Eliwell garantiza la máxima fl exibilidad y facilidad de instalación.  

 FREE Smart SMD – SMC presenta varios modelos en función de los cuales podemos disponer de 6 entradas 
 digitales, hasta 5 salidas en relé, hasta dos salidas tRiAC, hasta 2 salidas analógicas PWM, hasta 3 salidas 
 analógicas  0…10V/0…20mA/4…20mA confi gurables y hasta dos salidas digitales Open Collector para relé  
 externo. 

 El formato 4DiN garantiza la máxima fl exibilidad y facilidad de instalación.

la alimentación es a 12-24V~ o 12-24V~/24Vc 
Para más detalles consulte el manual de instalación FREE Smart.

 FREE Smart SMD4500 – SMC4500 / Expansi´pon SME4500 disponen de conectores extraíbles tanto para  
 las entradas de baja tensión como para las salidas de relé.
 Se presenta en varios modelos que pueden disponer de hasta 2 entradas digitales, 4 salidas de relé, hasta 2  
 salidas analógicas Open Collector PWM, hasta 2 salidas analógicas 0…10V, una salida 0…20mA/4…20mA 
 confi gurable o, como alternativa una salida 0…10V en modelos específi cos.
 
 El formato 4DiN garantiza la máxima fl exibilidad y sencillez de instalación.
 
 la alimentación es a 100-240V~ 

CONTINuIDAD CON ENERGY FLEX[1]

 FREE Smart hereda de la serie Energy Flex  las características de i/O y las conexiones eléctricas de
  los distintos modelos, que se combinan con sus correspondientes expansiones y teclados. las dos
 plataformas utilizan además los mismos accesorios.

 FREE Smart hereda además de la serie Flex la interfaz con el estándar Modbus RtU de 
 comunicación serial y la posibilidad de descargar mapas de parámetros y aplicaciones mediante  
 MFk.

1 Téngase en cuenta que la continuidad con Energy Flex No supone la herencia de las aplicaciones. 
 Las aplicaciones (ej. unidades de tratamiento de aire) son desarrolladas por Eliwell y están disponibles para su descarga en nuestra web.
 visite nuestra web y/o contacte con el Soporte tecnico para más información.

Smart
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SELECCIóN DE LA INTERFAz

Smart se encuentra disponible en 3 versiones, SMP para montaje en panel, SMD/SMC con montaje en guía Din:

SMP 32x74 SMD 4DIN con display SMC 4DIN ciego

la aplicación iEC creada desde Application puede cargarse indistintamente en todas las versiones. 
la navegación del menú es idéntica en todos los modelos. 
los modelos SMP y SMD tienen un display con 7-segmentos de lED de 4 dígitos. 
Con el modelo SMC, al carecer de display, es indispensabile utilizar un terminal para la confi guración. 
Sobre la descripción de las teclas, la interfaz de usuario y las conexiones consulte el manual de instalación cod. 9MAx0036[2] 

Smart 100-240va está disponible en 3 versiones, SMD/SMC4500 con montaje en guía DiN y módulo de expansión i/O 
SME4500 con montaje en guía DiN

SMD4500 4DIN con display SMC4500 4DIN sin display SME4500 expansión 4DIN 
sin display

la aplicación iEC creada por Application puede cargarse indistintamente en cualquier versión. 
la navegacón del menú es idéntica en todos los modelos-
El modelo SMD tienen un display de 7 segmentos de lED de 4 dígitos.
El modelo SMC, al ser sin display, necesita un terminal en el momento de la confi guración. 
Para la descripción de las teclas, de la interfaz de usuario y de las coneciones véase el manual de instalación la descrizione dei 
cod. 9MAx00363 .

2 (x = 0: IT; 1: EN;  2: FR; 3: ES; 5: DE)

Smart
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SELECCIóN DE LOS MóDuLOS OPCIONALES SMART
A continuación se exponen algunos accesorios utilizados por el Smart:

Terminal SkP 10 32x74 Terminal Skw22 
con display LCD

sin retro-iluminación

Terminal Skw22L 
con display LCD

con retro-iluminación

Terminal SkP22 
con display LCD

sin retro-iluminación

Terminal SkP22L 
con display LCD

con retro-iluminación

Expansiones (varios modelos dispo-
nibles) SE600 4DIN sin dsplay

• El terminal SKP 10 de montaje en panel dispone de una interfaz análoga a la del módulo principal Smart.
• El terminal SKW22 de montaje en pared dispone de una interfaz específica, en el display lCD con y sin retro-iluminación.  

Para su descripción consulte el manual instalación cod. 8MAx0218[3]

• El terminal SKP22 de montaje en panel dispone de una interfaz específica, en el display lCD con y sin retro-iluminación.  
Para la descripción consulte el manual instalación cod. 8MAx0218[4]

• las expansiones SE600 - disponibles en varios modelos - tienen las i/O similares a SMD

Para las conexiones y la descripción de módulos adicionales y accesorios consulte el manual de instalación cod. 9MAx0036[5]

3-4-5 (x = 0: IT; 1: EN; 2:FR; 3: ES; 5: DE)

Smart
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APLICACIONES COMPLEjAS
FREE Evolution ha sido diseñado para instalaciones de medianas y grandes dimensiones y en concreto para 

Constructores de:
• U.t.A. (Unidades tratamiento Aire)
• Chiller & Bombas de Calor
• Rooftop
• Centrales de Compresores  

Instaladores/integradores de:
• instalaciones de aire
• instalaciones hidrónicas
• instalaciones mixtas (aire/acqua)

CRITERIO DE SELECCIóN FREE EvOLuTION

EvD EvC

los modelos FREE Evolution están disponibles en la versión con montaje en guía 8 DiN, con display (modelo EvD) o sin di-
splay (modelo EvC) ambos provistos de bornes extraíbles lo que facilita un notable ahorro en el tiempo de cableado.

FREE Evolution EvD/EvC presenta varios modelos en función de los cuales podemos disponer de 9 entradas digitales, hasta 7 
salidas de relé, 5 salidas analógicas 0…10V/4…20mA confi gurables 

los modelos /u disponen además de un puerto USB y un mini-puerto USB de serie

El formato 8DiN garantiza la máxima fl exibilidad y facilidad de instalación.

la alimentación es a 24V~/c  o 48Vc 

Para más detalles consulte el manual de instalación FREE Evolution cod. 9MAx0042[6]

Evolution
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SELECCIóN DE LOS MóDuLOS OPCIONALES Y ACCESORIOS EvOLuTION
A continuación se muestran algunos accesorios utilizados por el Evolution:

Terminal Evk1000 Evk1000 montaje en pared

Expansión FREE Evolution EvE Plug-in EvS

• FREE Evolution EVD está disponible con un terminal de usuario gráfico integrado (built-in) mientras que el FREE Evolution 
EVC es un módulo ciego al que se conecta un terminal de usuario gráfico Evk1000 para la configuración de los paráme-
tros de BiOS 

• Evk1000 está disponible en la versión con montaje en panel: una base específica, disponible como accessorio, permite su 
montaje en pared

• la integración en sistemas industriales, BMS y redes Ethernet resulta posible gracias a los módulos plug-in EvS, disponi-
bles en formato 2DiN y que se conectan de modo rápido a los módulos principales

La expansión FREE Evolution EvE, sin display, tiene el mismo formato y dispone del mismo i/O del módulo principal
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CRITERIO DE SELECCIóN FREE PANEL

EvP3300/C EvP3500/C/Rh Base montaje en pared

los modelos FREE Panel (EvP)  están disponibles en la versión con montaje en panel: una base específica, disponible como 
accessorio, permite su montaje en pared
los modelos FREE Panel (EvP) son dos. 
1. FREE Evolution EvP 3300/C dispone de serial CANopen, RS485 Modbus RtU y EtHERNEt Modbus tCP, 3 entradas (1 a 

bordo NtC + 1 remota configurable NtC/De +1 remota configurable en corriente/tensión) 
2. FREE Evolution EvP 3500/C/Rh dispone de serial CAN, RS485 y EtHERNEt, 3 entradas (1 módulo humedad a bordo + 1 

a bordo NtC + 1 remoto configurable NtC/De) 

EVP dispone de un terminal de usuario gráfico 128x64px integrado (built-in) 
la alimentación es a 24V~/c  o 48Vc 

Para más detalles consulte el manual de instalación FREE Panel cod. 9MAx0046[7]

7 (x = 0: IT; 1: EN; 2:FR; 3: ES; 5: DE)

Panel
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CONECTIvIDAD
la característica fundamental de Evolution es su amplia conectividad 

FREE Panel (EVP) se utiliza como control de sistema, con funciones de gateway, usado en combinación con los controles FREE 
Evolution y FREE Smart o de terceras partes, garantizando prestaciones elevadas por lo que respecta a memoria, conectividad e 
interfaz de usuario. Resulta además de sencilla programación, mantenimiento y servicio. 
los modelos FREE Panel se encuentran todos disponibles con CANOpen RS-485 y EtHERNEt de serie. 
EVP permite: 
• gestionar un menú local realizado con FREE Studio User interface
• gestionar hasta 10 menús remotos, realizados con FREE Studio User interface, cargados por los respectivos FREE Evolution 

conectados en red
• compartir variables de red (binding) 

los modelos EvD/EvC se encuentran todos disponibles con CANOpen de serie. 
Se encuentran además disponibles las seriales RS485 o MPBUS a bordo, de serie, dependiendo del modelo. 
Cada EvD/EvC se conecta  a 12 expansiones EvE  mediante serial CANOpen o RS485
la integración en sistemas industriales, BMS y redes Ethernet puede realizarse gracias a los módulos plug-in, disponibles en 
formato 2DiN y que se conectan rápidamente a los módulos principales.
Cada Evolution puede conectarse hasta a dos terminales para visualizar el menú en el display situado a bordo de la máquina. 
también se puede, mediante la red RS485 conectar un sistema Smart que sirve de Esclavo a una red donde Evolution sirve 
de Maestro. El terminal Evk1000 se halla disponible con CANOpen de serie. El terminal Evk1000 puede leer el menú desde 
EvD/EvC. Se hallan además disponibles las seriales RS485 o MPBUS a bordo, de serie, en función del modelo. 

FREE Evolution y FREE Panel disponen de funciones WEB que ofrecen a los constructores e integradores de sistema un 
acceso remoto completo. la conexión mediante internet a sus propias máquinas reduce drásticamente los costes de asistencia 
y mantenimiento, minimizando las necesidades de desplazamientos. Supone igualmente un beneficio para los clientes finales, 
que pueden controlar su propia instalación, tanto local como remotamente, utilizando la interfaz gráfica inmediata de un nave-
gador estándar en su Smartphone, tablet y PC.

Las principales funciones wEB
• Acceso remoto a través de internet
• tele-lectura y tele-asistencia
• Control local y remoto de la instalación, 

incluyendo gestión de alarmas
• Mantenimiento preventivo y predictivo
• Notificación de alarmas mediante 

e-mail
• interfaz avanzada de la instalación en 

PC, tablet y SmartPhone.

FuNCIONES wEB SERvER : Para más detalles se recomienda la lectura del documento 
9IS24252_web_ApplicationNotes
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APLICACIONES
Eliwell pone a su disposición en su página web[1] aplicaciones y librerías de objetos para la plataforma FREE Way.
las aplicaciones y librerías de objetos le permiten agilizar su trabajo, haciendo que FREE Studio resulte aún más fácil de usar.

Aplicaciones Smart
Pueden descargarse, por ejemplo, distintas aplicaciones para UtA, que se diferencian según la complejidad de las máquinas 
que pueden controlar, desde simples unidades con canal de aire único y una batería hasta unidades más complejas con doble 
canal, baterías múltiples y recuperador.

Dichas aplicaciones, además de estar ya 
preparadas para su uso (siendo con-
formes a las reglas de su arquitectura), 
pueden modificarse fácilmente, para 
responder a necesidades más específi-
cas o particulares. 

Documentación Smart

la sección de la web contiene además la documentación:

Manual de Arquitectura o Desarrollador
Manual del Desarrollador que contiene las reglas de arqui-
tectura, pensado específicamente para los desarrolladores.

Manual user
Manual de Usuario de la 
aplicación.

1 En la dirección (visible previo registro y/o login en el área reservada http://www.eliwell.it/filedownload.aspx?id=20151

http://www.eliwell.it/filedownload.aspx?id=20151
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Aplicaciones Evolution
Puede descargarse, por ejemplo, la aplicación para UtA AHU03, para unidades complejas con doble canal, baterías múltiples y 
recuperador.

Dicha aplicación, además de estar ya preparada para su uso (siendo conforme a las reglas de su arquitectura), puede modifi car-
se fácilmente, para responder a necesidades más específi cas o particulares.

Documentación Evolution

la sección de la web contiene además la documentación:

Manual de Arquitectura o Desarrollador
Manual del Desarrollador que contiene las reglas de arquitec-
tura, pensado específi camente para los desarrolladores.

Manual user
Manual de Usuario de la 
aplicación AHU03
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El entorno de trabajo Application presenta varias secciones para el desarrollo de la aplicación iEC; programa-
ción en lenguaje compatible iEC 61131-3 , tests, depuración y descarga de la aplicación iEC al dispositivo target.
IMPORTANTE: Application descarga solo la aplicación IEC.  
La descarga de los parámetros (BIOS y PLC) y sus valores por defecto se realiza desde el Device y no desde 
Application.

A continuación detallamos el listado de las secciones (paneles):

Sección
Nombre Panel /

Sección

Application
Panel Descripción

A /
Barras (bar) 

de herramientas
 

Esta sección muestra las herramientasde trabajo 
mediante iconos.
Para visualizar o no las barras de herramientas basta con 
hacer click con la tecla derecha del ratón y seleccionar o 
deseleccionar las herramientas deseados.

Algunos instrumentos se pueden seleccionar 
mediante combinaciones de teclas (shortcuts). Ver su 
correspondiente capítulo para más detalles

B / variables
En este sección aparecen las variables globales y locales 
del código visualizado en la sección D ‘Edit’ (programas, 
bloques de función y funciones)

C

A

B

D

E

F

G

h

DEFINICIONES PANELES APPLICATION
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Sección
Nombre Panel /

Sección

Application
Panel Descripción

C Project Proyecto

El panel Proyecto se subdivide en 3 pestañas (tabs):
• Project - para la gestión del código aplicación
• Definitions - para la gestión y definiciones de 

variables complejas definidas por el desarrollador
• Resources - para la gestión del menú del dispositivo 

target

D / Edit Esta sección permite escribir el programa

E watch visualización de variables con 
aplicación ejecutándose

Este panel permite gestionar la depuración de las 
variables mediante la visualización de su estado en 
formato numérico cuando la aplicación está ejecutándose 
y conectada al dispositivo target

F Oscilloscope visualización gráfica de variables

Este panel (de igual modo que en el panel watch) 
permite gestionar la depuración de las variables 
mediante la visualización de su estado en formato gráfico 
cuando la aplicación está ejecutándose y conectada al 
dispositivo target

G Library Librería de funciones

Este panel permite gestionar las librerías de funciones 
por defecto y/o creadas por el desarrollador.
El panel se subdivide en varias pestañas (tabs), cada una 
para una librería. 
Están siempre disponibles las pestañas de:  
• Operator and standard blocks: operadores 

estándar (AND, OR, etc)
• Target variables: variables específicas del dispositivo 

target
• Target blocks: funciones específicas del dispositivo 

target
Otras pestañas adicionales se gestionan mediante el 
menú desplegable Project > Library manager

h Output Mensajes

Este panel muestra los mensajes correspondientes al 
desarrollo del proyecto (apertura de fichero, errores de 
compilación, estado de conexión al dispositivo target etc.)
Nota: la conexión al dispositivo target también puede 
verse abajo a la derecha de la pantalla con mensajes de 
color (ver Download Aplicación)

los paneles aparecen o no (ver capítulo Shortcuts) y pueden organizarse por lo que respecta a su disposición y dimensiones 
a gusto del usuario.
Studio memoriza las últimas configuraciones realizadas

Iconos
los instrumentos de trabajo se hallan disponibles mediante los menús desplegables o con shortcuts (atajos de teclado).
El panel A presenta una serie de iconos que facilitan al desarrollador la creación de la aplicación. 
las barras de herramientas se visualizan con el menú view > Toolbars
A continuación detallamos un listado de los iconos más utilizados para las Toolbar Main y Project

Main Toolbar

Project Toolbar

los iconos son 'self-explaining' es decir intuitivos. Además de los primeros iconos, que resultan análogos a los iconos estándar 
(Abrir proyecto, guardar proyecto, Copiar, pegar, etc) se hallan los iconos identificados por algunas letras situadas arriba:
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Barra herramientas Función Función Atajo teclado

F Main Pantalla completa Full Screen CtRl+U

w Main Visualiza panel proyecto WORKSPACE CtRl+W

O Main
Visualiza / oculta 

el panel de mensajes
OUtPUt CtRl+R

L Main
Visualiza / oculta 
 el panel librería

liBRARy CtRl+l

wa Main
Visualiza / oculta 

 panel ventana watch
WAtCH WiNDOW CtRl+t

A Main
Visualiza / oculta 

 panel osciloscopio
ASyNC gRAPHiC 

WiNDOW
CtRl+K

C PROjECt
Compilación de proyecto

-solo el seleccionado-
COMPilE F7

Ca PROjECt Compilación proyectos COMPilE All -

Si PROjECt
Apertura del 'simulador'
Ver capítulo Simulation SiMUlAtiON MODE -

Co PROjECt Conectados al target
CONNECtS tO tHE 

tARgEt
F5

Dc PROjECt Descarga código a la aplicación DOWNlOAD CODE -

Ins PROjECt
introduce un nuevo registro 

(variable, constante, alarma etc)
iNSERt RECORD -

Del PROjECt Borra un registro DElEtE RECORD -

Panel Project
Visualización detallada del Panel C / Project[1]

pestaña Project pestaña Definitions pestaña Resources

1 visualización para Smart
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PARA INICIAR

PRIMER ARRANQuE[1]

1. Haga click en el icono  Launch FREE Studio que se encuentra en el Escritorio
2. Haga click en el icono FREE Studio Application.

1 2

El programa aparecerá tal como se muestra en la figura:

Ahora podemos:
• Crear un nuevo proyecto ‘New Project ...’

• téngase en cuenta que el programa sugiere la selección del target Smart, Evolution o Panel
• en dicho caso elija FreeSmart
• los números situados al lado indican la versión (máscara) del firmware

• Abrir un proyecto existente ‘ Open project …’ 
• Abrir los proyectos recientes ‘Open an existing project ...’ seleccionándolos del listado
los proyectos existentes tienen la extensión .ppjs

la aplicación iEC se compone de un proyecto y de uno o varios programas escritos en código iEC

1 El logo 'free Smart' al comienzo de capítulo indica que la herramienta Application está disponible para el Smart. Todas las herramientas  
 (incluyendo Application) están disponibles para Evolution. Para Evolution recomendamos - en el primer Arranque y en la Creación de un nuevo 
 programa - que empiece siempre por la herramienta Connection  (véase a tal respecto su correspondiente capítulo).

Smart
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CREACIóN NuEvO PROYECTO

• Haga click en New Project ... o
• desde el menú desplegable seleccione File > New Project[2]

Aparece la ventana de diálogo que mostramos a continuación,  donde puede crear y guardar con nombre un nuevo proyecto:

Nuevo Proyecto

El nuevo proyecto se presenta tal como se muestra en la figura:

• Para la descripción de los iconos véase el capítulo Shortcuts (atajos de teclado)
• la descripción de los lenguajes de programación se encuentra disponible en el help en linea (Ayuda en línea, en inglés) - 

véase el capítulo Soporte
• la descripción de los paneles del entorno de desarrollo estándar se encuentra en el siguiente capítulo

A continuación mostraremos cómo crear, desarrollar y testar una nueva aplicación con ejemplos simples de librerías, bloques 
de función y programas sencillos.
 

2 En la imagen se muestra un ejemplo de proyecto para Smart. En Evolution es idéntico. Las excepciones se indicarán claramente. 
 Aconsejamos en este caso, empezar siempre por el tool Connection y luego seguir el procedimiento descrito en su correspondiente capítulo
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CREACIóN DE uN NuEvO PROGRAMA[3]

Panel Project / Carpeta Programs. 
Haga click en la tecla derecha del ratón y seleccione New Program.
Cada proyecto contiene por defecto el programa main

SELECCIóN DE LENGuAjE IEC

Aparece la ventana de diálogo:

Nuevo Programa en lenguaje ST

Seleccione el lenguaje de programación deseado e introduzca un nombre.
la plataforma FREE STuDIO es compatible con los 5 lenguajes de programación estándar (IEC 61131-3).

 . . . . . .

. . . . . . . .

. . . . . . . .

. . . . . . . .

. . . . . . . .

. . . . . . . .

 . . . . . .

Init

Step0

SW1

 . . . . . .

. . . . . . . .

. . . . . . . .

. . . . . . . .

. . . . . . . .

. . . . . . . .

 . . . . . .

Main Start

En1

En2

En3

N

/

 . . . . . .

. . . . . . . .

. . . . . . . .

. . . . . . . .

. . . . . . . .

. . . . . . . .

 . . . . . .

MAX
In1

In2

ld  true
st  blinker.run
ld  true
st  blinker.run
cal trigger

ld  true
st  blinker.run
cal trigger

var2:=var2+1;
if  (var2=200) then
   var2: =0;
   var1: =not var1;

counter: =counter+1;
if  (DI2=TRUE) then
   out1: =counter and 5;
   out2: =counter and 7;
   out3: =counter and 12;
else
  

ST FBD IL SFCLD

Cada proyecto puede estár formado por varios programas
El desarrollador puede utilizar uno o varios lenguajes en el mismo proyecto. Cada nuevo programa puede seleccionarlo entre 
los 5 lenguajes de programación, 2 de tipo texto y 3 de gráficos:
• ST, Structured Text language    de texto
• FBD, Functional Block Diagram language  gráfico
• LD, Ladder language    gráfico
• IL, Instruction List language    de texto
• SFC, Sequential Function Chart language  gráfico

APERTuRA DE uN PROGRAMA EXISTENTE

Si el desarrollador ya tiene a disposición una aplicación iEC existente basta con abrir un proyecto .ppjs desde el menú File > 
Open Project o seleccionarlo del listado.

3 Creación de un nuevo programa (New program)



FREE Studio - Quick Start  pág. 26

ESCRITuRA PROGRAMA

En el panel Edit escriba el programa que desea desarrollar.
A continuación le mostraremos de manera general los elementos de la herramienta de desarrollo.  
En el Apéndice encontrará algunos ejemplos de programas simples que puede utilizar para crear un proyecto básico que fun-
cione.

PANEL PROjECT / PESTAñA PROjECT

Creación de variables locales
En el menú desplegable seleccione variables > Insert (new record) o haga click en su correspondiente icono.
En la sección central aparece la variable en amarillo, desde donde podemos definir las características haciendo click en las 
correspondientes casillas. 
En caso de que haya selecciones multiples se puede, haciendo click sobre los puntos suspensivos (…) elegir entre un conjunto 
de opciones. 
Se abrirá una ventana de diálogo 
• Name (Nombre)
• type (tipo) a elegir entre una de las opciones predefinidas o entre las variables definidas por el usuario (ver imagen)
• Address (dirección): por defecto es automática
• Array: define si la variable es de tipo array (en este caso defina su dimensión) o no
• init value: valor inicial
• Description (descripción)

En el desplegable de navegación, bajo la carpeta del programa, aparecerán las variables locales identificadas con un icono 
Nota: las variables locales No son estáticas.

Creación Bloque de Función / Función
Del mismo modo que se crea un programa se puede crear 
• una función 
• un bloque de función 
en el lenguaje de programación deseado.
Nota: la creación de una función se halla disponible en 4 lenguajes de programación. El lenguaje SFC no está soportado para 
las funciones.

Una función o bloque de función es un (sub)programa que dispone de entradas y salidas:
• una función prevé n entradas y una única salida (RESuLT) con el mismo nombre de la función. la memoria local de la fun-

ción se inicializa a cada llamada de la función
• un bloque de función prevé n entradas y m salidas. la memoria local de cada instancia del bloque de función se conserva 

entre una llamada y la posterior (memoria estática)

Cada función o bloque de función se puede utilizar dentro de un programa simplemente arrastrando (drag & drop) el icono a la 
sección Edit del programa.  

la función se utiliza (rellamada) dentro del programa pasando las variables de entrada.
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El bloque de función se usa dentro del programa como instancia del mismo modo que se declara una variable.

Ejemplo en lenguaje ST de llamada de función y function block

Creación de variables Globales
En el menú de navegación se encuentra la carpeta Global variables
Desde aquí se pueden crear nuevas:
• Variables (variables globales)
• Mapped variables (mapeadas)
• Constant (Constantes)
• Retain variables[4]

Recursos Globales Compartidos 
los recursos globales compartidos (global Shared) aparecerán en esta sección pero se definirán en el panel Resources.

4 Actualmente no soportadas en el target Smart y Evolution
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ASOCIACIóN DEL PROGRAMA A uN TASk
Para que el programa se ejecute es necesario asociarlo a un ‘task’. los task son de varios tipos:
• Boot. task ejecutado una sola vez al iniciar el sistema 
• Init. task ejecutado a cada descarga de la aplicación y al iniciar el sistema (tras un Boot) 

Nota. El programa asociado inicializa slaves y mensajes, dependiendo de la configuración, a valores fijos independientes 
del tiempo de ejecución 

• Timed. task ejecutado a intervalos regulares con intervalo configurable por el desarrollador. Por defecto cada 100ms. task 
ejecutado a intervalos regulares con periodo regulable por el desarrollador. Por defecto cada 100ms.  
Nota. los mensajes Modbus no interfieren sobre dicho task

• Background. task ejecutado con prioridad inferior (una o varias veces entre el final de un task Timed y el inicio del siguiente).  

Además de los mencionados está disponible el task (solo máscara firmware 542.*) :
• Modbus. task ejecutado para implementar Modbus Master llamando correspondientes “function block” y para el envío de 

mensajes. 
Nota Cada nuevo proyecto tiene el programa main asociado al task de background (el programa main puede, en todo caso, 
ser eliminado y/o asociado a otros task).

Para activar un task situése sobre el task deseado y con la tecla derecha del ratón seleccione Add program

PANEL PROjECT / PESTAñA RESOuRCES
la pestaña Resources permite definir los parámetros EEPROM y las variables de estado que podrán utilizarse luego en el 
código de la aplicación (aparecerán en la sección Project>Global Shared) y permite construir el menú Prg (Programación), el 
menú Set Estados[5] y Alarmas del target FREE Smart / Evolution además de la interfaz del proyecto actual que se visualizará 
en FREE Studio Device
la pestaña Resources incluye las siguientes secciones:

MODBuS OBjECTS
Esta sección permite definir parámetros EEPROM y variables visualizables en el target, Device y que pueden leerse mediante 
protocolo Modbus® RtU. En todas las secciones se pueden añadir o quitar parámetros/variables igual que en las variables de la 
pestaña Project

EEPROM Parameters

En esta sección se crean las variables que el desarrollador pretende guardar incluso en caso de fallo de alimentación en el 
dispositivo target. Nota: el uso de los parámetros en el código es solo de lectura, la escritura puede realizarse utilizando las 
funciones correspondientes de FREE Smart.
Estado variables 
En esta sección definimos las variables de estado que podrán visualizarse en el Menú del dispositivo target.
Cada variable dispone de una transcodificación en el instrumento debido al display 4 dígitos/ 7-segmentos.  En la casilla 
Display label se puede elegir la transcodificación y ver la previsualización de cómo aparece en el display haciendo click en los 
puntos suspensivos (…)
Nota: algunas letras no se visualizarán (ej. x y z) por lo que en el display quedará un espacio vacío. 
Si la etiqueta en el display es zzz en el display no aparece nada
Si la etiqueta en el display es SET en el display aparece SEt.

5  Solo para Smart. ver manual Instalación 9MAx0036  (x = 0: IT; 1: EN; 3: ES; 5: DE)  
 En el Evolution el menú se define desde userInterface.

Smart
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EEPROM Parameters

Análogo a Smart

Estado variables

En esta sección definimos las variables de estado que podrán visualizarse en el Menú del dispositivo target.

 
En la columna target se indican las columnas visibles solo en el target Smart, Panel o Evolution. 
Donde no se indica lo contrario se entiende que es para ambos.

Target Columna Descripción

IPA indice pre-asignado

address dirección Modbus® del recurso

Name nombre del recurso que podrá utilizar el desarrollador en el código 
aplicación iEC

Smart display label nombre eventual visualizado en el menú aplicación del target (4-dígitos)

Device Type tipo de dato visualizado en target y Device

Default value /Min/Max valores mínimos/máximos por defecto de los recursos visualizados en el 
target y Device

Format

formato de visualización de los valores Default value /Mín/Máx
por ej. XXX.Y visualización de un entero con punto decimal
por ej. hh.MM visualización de un horario en formato horas:minutos
FREE Studio convierte automáticamente un entero de formato minutos al 
formato horas:minutos. Ejemplo. 75  1: 15

Application Type tipo de dato que se utiliza en el código aplicación iEC

Scale/Offset coeficientes de conversión entre Device Type y Application Type
Application Type = scale* Device Type + offset

Panel
Evolution Size Significativo solo en caso de tipo STRING. Dimensión (longitud) de la 

secuencia de caracteres. Por defecto y máximo= 31 caracteres.

unit Unidad de medición del Device Type visualizada en Device y si está 
disponible con icono en el target

Smart Access Level Ver tabla de Visibilidad. Para Evolution esta columna es irrelevante.

Read only Habilita/deshabilita la modificación de Status variables.

Description/Note texto libre visualizado en Device

Enums

Smart • Panel • Evolution 

Panel • Evolution
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En esta sección definimos los tipos de variables adicionales que pueden utilizarse en la columna Device Type[6]

BIOS parameters
En esta sección definimos posibles variaciones al mapa parámetros de BiOS configurados por defecto en fábrica por Eliwell

MENú TARGET
El menú target se halla compuesto por un menú BiOS + un menú Aplicación
El menú BiOS está pre-configurado de fábrica[7]. 
la tabla siguiente define las principales funciones de las teclas / lED del dispositivo target

tecla pulsación Descripción

F5 breve pasar de menú BiOS a menú Aplicación y viceversa

F1 o F3 breve navegación en carpetas y modificación de los valores

F2 breve anula operación (función ESC)

F4 breve acceso al menú set

F2+F4 breve acceso al menú Prg

F1/F2/F3/F4 prolongada gestionada por el desarrollador (mediante target variable syskeyFunctions[])

los lED los gestiona el desarrollador mediante target variable sysLocalLeds[])

Menú Prg[8]

En esta sección definimos el menú Prg y las carpetas/variables que lo compondrán.
El menú Prg puede estar compuesto por una o varias carpetas, definidas por el desarrollador, dentro de las cuales se introducen 
• EEPROM parameters
• Status variables
• BiOS parameters
• entradas y salidas

Menú set[9]

En esta sección definimos el menú set y las carpetas/variables que lo compondrán.
la creación del menú de set es análoga a la del Menú Prg
El menú set contiene la carpeta Al - ver abajo

visibilidad de los recursos del  menú
la visibilidad de los recursos creados por el desarrollador se describe en la siguiente tabla:

Columna Access Level visibilidad en Device visibilidad en el target Notas

Siempre visible
Always visible Si Si

Objeto asignado a un menú Prg 
o set

Nivel 1
Level 1 Si

Si 
nivel 1

Nivel 2
Level 2 Si

Si 
nivel 2

Nunca visible
Never visible Si NO

Nunca visible
Never visible

Si
Visible en la carpeta 
ALL PARAMETERS

NO Objeto No asignado a ningún 
menú Prg o set

Alarms
Es posible definir variables de alarma cuyo estado ha de gestionar el desarrollador.
En caso de que la variable asuma un valor distinto de cero la etiqueta se visualizará en la carpeta Alarmas (Al)del menú set de 

6 ver tabla de definición EEPROM parameters y Status variables
7 ver manual de instalación
8 Los elementos introducidos en la tablas de esta sección se visualizarán en Device
9 Los elementos introducidos en la tablas de esta sección se visualizarán en Device

Smart
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FREE Smart
En el target Evolution es solo una declaración uSINT de tipo global

Configuración FREE Smart
Desde la pestaña Resources haciendo click en FREE Smart accedemos al siguiente panel FREE Smart Configuration

Mediante el menú desplegable se puede configurar el valor de la variable / parámetro que se pretende visualizar en el instru-
mento FREE Smart como visualización principal (Fundamental state display). Si no selecciona ningún valor (none) el instru-
mento visualizará PLC.
los valores disponibles son todas los I/O[10] + los valores definidos por el desarrollador en el Menú set

Execution time
En el mismo panel es posible configurar el tiempo de ejecución del proyecto en milisegundos (ms).
El valor por defecto es 100ms. El rango se define entre 20ms y 100ms[11]. 

I/O mapping
En esta sección definimos los lazos de unión entre variables y las i/O físicas del FREE Smart.
• Local: variables locales de la base SMD/SMC
• Extended: variables de la expansión SE
• Remote: variables presentes en los terminales SKW / SKP

Evolution 

MENú TARGET
El menú target se crea mediante userInterface. 
El menú BiOS sale pre-configurado de fábrica[12] y puede verse en el Device. 
las principales funciones de las teclas / lED del dispositivo target se programan mediante userInterface[13]

Menús
En esta sección definimos un Menú 'ficticio' que no aparece en el display, así como las carpetas/variables que lo compondrán.
El menú podrá estar formado por una o varias carpetas, definidas por el desarrollador, dentro de las cuales se introducen 
• EEPROM parameters
• Status variables

Alarms
las alarmas para Evolution se definen únicamente para permitir la portabilidad de un proyecto Smart

10 Las I/O son todas las entradas y salidas locales y remotas, incluyendo las de los terminales. Consulte el manual de instalación para más detalles.
11 ver también la sección Asociación programa a un task
12 ver manual de instalación
13 LEDS programables también con Application
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Configuración FREE Evolution
Desde la pestaña Resources haciendo click en FREEEvolution se accede al siguiente panel FREE Evolution Configuration

Execution time
En este mismo panel se puede configurar el tiempo de ejecución del proyecto en milisegundos (ms).
El valor por defecto es 20ms. El rango se define entre 20ms y 100ms[14]. 

I/O mapping
En esta sección definimos los lazos de unión entre variables y las i/O físicas del Evolution.
• Local: variables locales de la base EvD/EvC
• Field: variables y/o binding de controles de terceras partes

Nota
Si han sido correctamente definidas[15] todas las variables definidas en Resources aparecerán automáticamente en la sección 
Global Shared. 

Panel 
Configuración FREE Panel
Desde la pestaña Resources haciendo click en FREEEvolutionEvP se accede al siguiente panel FREE Evolution Configuration

14 ver también la sección de Asociación programa a un task
15 El proyecto ha de guardarse sin errores para que las variables continuen siendo visibles en la pestaña Project en Global Shared
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Execution time
En este mismo panel se puede configurar el tiempo de ejecución del proyecto en milisegundos (ms).
El valor por defecto es 20ms. El rango se define entre 20ms y 100ms[16]. 

I/O mapping
En esta sección definimos las relaciones entre variables y las i/O físicas de EvP[17].
• Local: variables locales de EvP
• Field: variables y/o binding de controles de terceras partes

Entradas Analógicas
téngase en cuenta que las entradas se encontrarán presentes o no dependiendo del modelo.

Entrada Sonda Tipo EvP3300/C EvP3500/C/Rh

AIL1 a bordo NTC a bordo 4 4

AIL2 remota
no incluída

NTC 103AT / NTCNk103 / De 
configurables

4 4

AIL3 remota
no incluída

4...20mA / 0-5v / 0-10v configurables 4 -

AIL4 a bordo %hR a bordo - 4

Nota
Si han sido correctamente definidas[18] todas las variables definidas en Resources aparecerán automáticamente en la sección 
Global Shared.

16 ver también la sección de Asociación programa a un task
17 En realidad EvP tiene solo 4 entradas analógicas AIL1...AIL4 y ninguna salida
18 El proyecto ha de guardarse sin errores para que las variables continuen siendo visibles en la pestaña Project en Global Shared
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GESTIóN PROYECTOS

GuARDADO PROYECTOS

Una vez completado el proyecto podemos salvarlo en varios formatos y enviarlo a Desarrolladores (Developers) o a Usuarios 
(users) de terceras partes

Tipos de ficheros

Target Tipo de fichero Aplicación Descripción

Smart .PPjS Application Proyecto creado con Application para abrir con Application

Panel
Evolution

.PPjS Application
Connection

Proyecto creado con Application que se puede añadir a un dispositivo 
Evolution con Connection

.PLL Application librería creada por el desarrollador para utilizar en Application o Device

.RSM Application Proyecto .PPjS compresso

Panel
Evolution

.PAjX user Interface Proyecto creado con userInterface para abrir con userInterface

Panel
Evolution

.PPjX user Interface Análogo a .PPjS. Proyecto compartido

Smart .CFN Device Proyecto creado con Application para abrir con Device 
Nota. No está disponible el código fuente pero el proyecto puede 
descargarse en el dispositivo target

Panel
Evolution

.CFN Device Proyecto creado con Application o Connection para abrir con Device. 
Si el dispositivo se crea con Connection contiene tanto la aplicación PLC 
como el menú hMI 
Nota. No está disponible el código fuente pero el proyecto puede 
descargarse al dispositivo target

TRANSFERENCIA DE PROYECTOS Y FIChEROS

En la siguiente tabla podemos ver algunas operaciones de transferencia de proyectos de un desarrollador a otro desarrollador 
o de un desarrollador a un usuario. la transferencia de datos supone el envío de uno o varios de los ficheros definidos en la 
sección anterior.

Proyecto De -->A Aplicación Tipo fichero Notas

El desarrollador (Developer) quiere transferir un 
proyecto a otro desarrollador
El desarrollador envía un fichero .ppjs 

El desarrollador que lo recibe puede abrirlo 
y modificarlo con Device Application; El 
desarrollador  se conecta al target, compila y 
descarga la aplicación.

Desarrollador


Desarrollador

Application .PPjS

El desarrollador envía un fichero .ppjs a otro 
desarrollador 

El desarrollador que lo recibe puede abrirlo y 
modificarlo con Application; El desarrollador  
se conecta al dispositivo target y compila la 
aplicación.
tras la compilación el desarrollador selecciona 
el elemento del menú Developer > Open 
with FREE Studio Device y configura la BiOS 
del dispositivo target (parametrización del 
dispositivo target)

Desarrollador


Desarrollador

Application
Device

.PPjS
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Proyecto De -->A Aplicación Tipo fichero Notas

El desarrollador desea transferir un proyecto a 
un usuario (User)
El desarrollador envía un fichero .CFN
El usuario que lo recibe puede abrirlo con 
Device; El usuario se conecta al dispositivo 
target descarga la aplicación y configura el BiOS 
del dispositivo target (parametrización)

Desarrollador


usuario

Device .CFN Desde el Device 
el usuario No 
puede compilar la 
aplicación

El desarrollador quiere realizar la depuración de 
una aplicación iEC ya presente en el dispositivo 
target , pero no tiene el código fuente.
El desarrollador recibe la carpeta completa 
del proyecto (que incluye los ficheros binarios 
y los símbolos de depuración) utilizado para 
descargar la aplicación iEC al  dispositivo target.
Nota: el proyecto no ha sido modificado 
(ninguna modificación a la fuente y ninguna 
recompilación y/o descarga)

Desarrollador


Desarrollador

Application Carpeta 
proyecto
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MODALIDAD DE CONEXIóN

Para descargar las aplicaciones iEC de Studio desde el Ordenador Personal al dispositivo target Smart  se necesitan algunos 
módulos adicionales.
Véanse las siguientes tablas, donde se muestran las posibles operaciones:

Multi Function key / DMI
PC          MFk

Multi Function 
Key

DMI

TTLUSBUSB

utilice cable TTL azul 
para la conexión DMI - MFk

Dirección de la

Descarga Datos
 

Mapa parámetros - -

Aplicación iEC  -

BiOS  -

Multi Function key 
MFk       Smart

Multi Function 
Key

TTL

free Smart

utilice cable TTL amarillo
para la conexión MFk - target
Dirección de la

Descarga Datos
 

Mapa parámetros  

Aplicación iEC  -

BiOS  -

Direct
PC          Smart

free Smart
DMI

TTLUSBUSB

utilice cable TTL amarillo
para la conexión DMI - target

Dirección de la

Descarga Datos
 

Mapa parámetros  

Aplicación iEC  -

BiOS  -

Nota: en el caso Direct Smart no se conecta a tierra.
Para la descripción completa del uso de MFK véase la correspondiente Application Notes MFk cod.9IS24233 EN-IT.

Para descargar las aplicaciones iEC de Studio desde el Personal Computer al dispositivo target Evolution  se necesitan algu-
nos módulos adicionales.
Véanse las siguientes tablas donde se muestran las posibles operaciones:

uSB host
uSB     Evolution

Dirección de la

Descarga Datos
 

Mapa parámetros  

Aplicación iEC  

Aplicación HMi  

File datos  

BiOS  -

uSB device
PC       Evolution

FREE Evolution

USBUSB

Dirección de la

Descarga Datos
 

Mapa parámetros - -

Aplicación iEC  

Aplicación HMi  

File datos  

BiOS - -

uSB-RS485 
uSB-CANOpen

EThERNET
PC         Evolution

FREE EvolutionUSB/RS485

RS485USBUSB

FREE EvolutionUSB/CAN

CANUSBUSB

FREE Evolution
+ Plug-in ETH

ETHERNET

Dirección de la

Descarga Datos
 

Mapa parámetros  

Aplicación iEC  -

Aplicación HMi  -

File datos  

BiOS  -

Nota: la conexión mediante EtHERNEt necesita el módulo plugin EVS

Smart

Evolution
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Panel
Para descargar las aplicaciones iEC de Studio desde el Ordenador Personal al dispositivo target Panel  se necesitan algunos 
módulos adicionales.
Véanse las siguientes tablas, donde se muestran todas las posibles operaciones:

uSB-RS485 
uSB-CANOpen 

EThERNET
PC         Evolution

FREE PanelUSB/RS485

RS485USBUSB

FREE PanelUSB/CAN

CANUSBUSB

FREE Panel

ETHERNET

Dirección de la

Descarga Datos
 

Mapa parámetros  

Aplicación iEC  -

Aplicación HMi  -

File datos  

BiOS  -

Nota: la conexión mediante EtHERNEt No necesita ningún módulo adicional.
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DOwNLOAD APLICACIóN IEC EN EL TARGET

las operaciones de conexión y descarga de la aplicación para Smart y Evolution son diferentes.
A continuación se expone la modalidad de conexión (ver correspondiente apartado) 
• Red (Network) para Smart 
• USB-R85 para Evolution
la descarga propiamente dicha se efectuará del mismo modo para los dos target

Smart

OPERACIONES PRELIMINARES
El usuario, para descargar correctamente la aplicación, debe:
1. conectar la interfaz hardware DMi al PC.
2. Asegurarse de haber instalado el driver - ver sección Setup interfaz DMi.

Configuraciones COM[1]

Seleccione, en el menú desplegable, Communication > Settings
El puerto COM ha de haber sido leído/configurado previamente en “gestión Periféricos” (Ver sección lectura del puerto COM 
de la interfaz DMi) para que se reconozca el mismo. En caso de errores consulte  “Error de conexión con la interfaz DMI”.

Para Smart seleccione EwDMI o Modbus[2]. Si el protocolo no está activado pulse la tecla Activate
Una vez seleccionado un valor para el puerto COM, dicho valor se memoriza, y vuelve a presentarse cada vez que se accede 
al programa, hasta que se modifica. las propiedades pueden verse y modificarse en el panel Communication > Settings > 
Properties[3]

Error de conexión con la interfaz DMI
1 Las configuraciones COM se configuran para todos los entornos de trabajo Application, Device y userInterface
2 En el caso Modbus solo para modelos /S con velocidad máxima 19200 baudios. TTL no utilizable.
3 Naturalmente el protocolo ha de ser Activado (Activate) previamente.
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Error de Apertura Puerto Serie
En caso de Aviso “Error de Apertura Puerto Serie” proceda como le indicamos a continuación:

1. Controle que el número del puerto COM configurado en el programa es el mismo que el leído en lectura del puerto COM 
de la interfaz DMI.

2. En el caso de que sean efectivamente iguales desconecte y vuelva a conectar físicamente la interfaz DMI del puerto USB. 
Dicha acción debería conseguir que el sistema operativo reconozca la interfaz.

3. Repita la operación función identifica DMI.

TARGET SMART
Smart dispone de algunos parámetros presentes en la carpeta CF para la gestión de la conexión entre el target y Studio

Si el target está 'vacío'[4], es decir si no hay ningún aplicación IEC en el dispositivo,  Smart visualiza en el display el mensaje 
FrEE:

set 

esc 
F1 F2

F3 F41 2 3 4 5 6 7

F5

Para acceder al menú de parámetros 
hay que pulsar al mismo tiempo la 

tecla esc y la tecla set. De este modo 
accederemos al menú PAr.

set 

esc 
F1 F2

F3 F41 2 3 4 5 6 7

F5

El menú de parámetros PAr contiene 
todas las carpetas del instrumento. 
Para visualizar las carpetas pulse la 

tecla set.

set 

esc 
F1 F2

F3 F41 2 3 4 5 6 7

F5

la primera carpeta visualizada será 
la carpeta CF de configuración. Para 

visualizar los parámetros de la carpeta 
pulse la tecla set.

set 

esc 
F1 F2

F3 F41 2 3 4 5 6 7

F5

El primer parámetro visualizado será 
CF30. Para visualizar el valor del pará-

metro pulse la tecla set.

set 

esc 
F1 F2

F3 F41 2 3 4 5 6 7

F5

Utilice las teclas UP y DOWN para 
modificar el valor si es necesario. Para 

confirmar el valor pulse la tecla set.
Para salir pulse esc

set 

esc 
F1 F2

F3 F41 2 3 4 5 6 7

F5

Con las teclas UP y DOWN desplácese 
a los otros parámetros y repita el pro-
cedimiento para visualizar los valores 

y - si es necesario - modificarlos 

Parámetros necesarios para la correcta conexión entre el target Smart y Studio.[5]

Parámetro Descripción valores Por defecto visibilidad Notas

CF01* selección protocolo de la COM1 
(ttl)

0 = Eliwell
1= Modbus

1 2
Es obligatorio configurarlo 

en 1 

CF30 dirección control protocolo 
Modbus

1...255 1 3

Compruebe que los valo-
res configurados resultan 

congruentes con lo que se 
ha definido  en el panel 
Communication > Set-

tings  > Properties 

CF31** baudate protocolo Modbus

0,1,2 = no usado
3 = 9600 baudios

4 = 19200 baudios
5= 38400 baudios
6 = 57600 baudios

7 = 115200 baudios

3 3

CF32 paridad control protocolo 
Modbus

1 = EVEN
2= NONE
3 = ODD

1 3

* COM1 = ttl / RS485 (modelos/S): no se utilizan simultáneamente

** CF31 
5=38400 baudios (RS485: no soportado)
6=57600 baudios (RS485: no soportado)
7=115200 baudios (RS485: no soportado)

4 En caso contrario (en Smart se halla presente una aplicación IEC) aparece en el display el mensaje PLC. 
 utilice al mismo tiempo las teclas uP y DOwN para visualizar el mensaje FrEE
5 Para los otros parámetros y para la gestión de las visibilidades consulte el manual de Instalación Smart
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Evolution

Configuraciones COM[6]

las configuraciones son análogas a lo ya descrito para Smart:
panel Communication > Settings 
Para Evolution No ha de seleccionarse EwDMI

• Seleccione CAnOpen en el caso de conexión USB/CAN
• Seleccione Modbus en el caso de conexión USB/RS485
• Seleccione Modbus TCP en el caso de conexión Ethernet mediante el correspondiente plug-in

Si el protocolo no se halla activado pulse la tecla Activate

las propiedades, también en este caso,  pueden verse y modificarse en el panel Communication > Settings > Properties
 Communication > Settings > Properties[7]. El panel visualizado depende del protocolo activado:

CANOpen Modbus ModbusTCP/IP

Modbus TCP
El campo IP or hostname permite introducir una dirección iP en la red local (la configuración por defecto del Evo-
lution es 10.0.0.100) o un nombre huésped si el router (iP estática) ha sido configurado para ello.
El campo  Port Puerto de comunicación tCP/iP ya está compilado por defecto a 502.

6 Las configuraciones COM valen tanto en Application como en Device
7 Naturalmente el protocolo ha de Activarse (Activate) anteriormente
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MODBuS TCP/IP

 

TARGET EvOLuTION
Evolution, dispone de algunos parámetros BiOS para la gestión de la conexión entre el target y Studio pero, a diferencia de 
Smart, no tiene un menú por defecto presente en el display on board o remoto.[8]

Para visualizar los parámetros resulta por tanto necesario abrir Device
Parámetros necesarios para la correcta conexión entre el target Evolution y Studio[9]:

Se muestran los dos protocolos disponibles on board. Para los protocolos disponibles en el módulo plug-in consulte el manual 
de instalación.

Parámetro Descripción valores Por defecto Notas

Baud_RS485_OB Baudrate protocolo RS485 
On Board

0=9600 baudios
1=19200 baudios
2=38400 baudios 
3=57600 baudios
4=76800 baudios

5=115200 baudios

2

Addr_RS485_OB Dirección serial RS485 On 
Board 

1...255 1

la dirección efectiva viene 
establecida por la suma 

de este valor + el valor que 
asume el dip-switch

Proto_RS485_OB
Selección protocolo RS485 

On Board
2 = uNEt

3 = Modbus/RtU
3

Databit_RS485_OB Número bit de dato RS485 
On Board

8 Fijo a 8

Stopbit_RS485_OB Número bit de stop RS485 
On Board

1= 1 bit de stop
2= 2 bit de stop

1

Parity_RS485_OB Paridad protocolo RS485 
On Board

0= NUll
1= ODD
2= EVEN

2

8 Eliwell le proporciona ejemplos de menú hMI de configuración parámetros BIOS
9 Para los otros parámetros consulte el manual de Instalación Evolution

• Conectar el cable Ethernet del PC a FREE Evolution
• Haga doble clic sobre el icono de los PC situado en la 

parte inferior derecha de la barra de aplicaciones.
• Seleccione el protocolo tCP; clique en Propiedades
• Configure el puerto Ethernet de su PC con direc-

ción como se muestra en la imagen (10.0.0.101). 
Nota. la configuración por defecto del Evolution es 
10.0.0.100: el puerto Ethernet del PC se configura 
pues con dirección distinta del valor por defecto (por 
ej. 10.0.0.101, los primeros 3 campos han de ser igua-
les y el cuarto diferente)

• Haga click en ok: el PC se halla configurado para dia-
logar con el FREE Evolution en el puerto Ethernet.
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Ethernet on board 

Parámetro Descripción valores Por defecto Notas

Baud_CAN_OB Baudrate protocolo CAN 
On Board

2=500 Kbaudios
3=250 Kbaudios
4=125 Kbaudios
5=125 Kbaudios
6= 50 Kbaudios

2

Addr_CAN_OB Dirección serial CAN On 
Board 

1...127 1

la dirección efectiva viene 
establecida por la suma 

de este valor + el valor que 
asume el dip-switch

EThERNET PLuGIN PASSIvE
Para los protocolos disponibles en módulo plug-in consúltese el manual de instalación
A continuación solo se indica la siguiente 
Nota:
los parámetros de configuración EtHERNEt en plug-in pasivo prevén la configuración del puerto de comunicación tCP/iP  (por 
ej. 502), la dirección IP, el gateway (pasarela) y la subnet mask
Para las conexiones en red local punto-punto los parámetros ‘Default gateway’ y ‘Net mask’ no resultan significativos.
Para las conexiones utilizando router los valores de los parámetros ‘Default gateway’ han de ser coherentes con la dirección iP, 
como en el siguiente ejemplo:

Parámetro Descripción Por de-
fecto valor parámetro Descripción

campo 
(IP &  

Gateway)

Por de-
fecto valor

Ip_1_ETh_PI Ethernet passive Plug-in 
iP address (1st part)

10 192 DefGtwy_1_
ETh_PI

Default gateway
(1st part)

0 … 255 192 192

Ip_2_ETh_PI Ethernet passive Plug-iniP 
address (2nd part)

0 168 DefGtwy_2_
ETh_PI

Default gateway
(2nd part)

0 … 255 168 168

Ip_3_ETh_PI Ethernet passive Plug-in iP 
address (3rd part)

0 0 DefGtwy_3_
ETh_PI

Default gateway
(3rd part)

0 … 255 0 0

Ip_4_ETh_PI Ethernet passive Plug-in iP 
address (4th part)

100 100 DefGtwy_4_
ETh_PI

Default gateway
(4th part)

0 … 255 1 1

Panel
Configuraciones COM
las configuraciones son análogas a lo ya dicho anteriormente para Evolution:
• Seleccione Modbus TCP en el caso de conexión Ethernet[10]

TARGET PANEL
Panel, dispone de algunos parámetros BiOS para la gestión de la conexión entre el target y Studio
El menú por defecto presente en el display (menú DiA) puede verse pulsando al mismo tiempo las teclas UP y ESC.
El menú por defecto presente en el display muestra solo los parámetros para el protocolo CAN.
Para visualizar los demás parámetros hay que abrir Device.

los protocolos RS485 y CAN disponibles on board son análogos a Evolution. 
A continuación se muestran los parámetros del protocolo Ethernet.

Ethernet on board 

Parámetro Descripción Rango Por defecto notas

IP_1_ETh_OB Ethernet passive On Board 
iP address (1st part)

0...255 10 por defecto
EtH: 010.000.000.100

Dirección MAC 
(ej: 0,1,2,50,60,70

Dirección iP 
(ej : 192,168,0,150)

IP_2_ETh_OB Ethernet passive On Board 
iP address (2nd part)

0...255 0

IP_3_ETh_OB Ethernet passive On Board 
iP address (3rd part)

0...255 0

IP_4_ETh_OB Ethernet passive On Board 
iP address (4th part)

0...255 100

10 No es necesario un módulo adicional
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hMI management
Además de los parámetros BiOS Panel gestiona el menú HMi

hMI management

Parámetro Descripción valores Por defecto Notas

hmi_language idioma  en el display (local o 
remoto)

0 … 65535 0

hMIList_current Hmi actual

0= HMi remota 1
1= HMi remota 2
2= HMi remota 3
3= HMi remota 4
4= HMi remota 5
5= HMi remota 6
6= HMi remota 7
7= HMi remota 8
8= HMi remota 9

9= HMi remota 10
10= no usado
11= HMi local

11

HMi local es identificada 
como  Network en el 

display
En Connection como HMi

HMi remota es identificada 
en Connection como 

hMI Remote

hMI remote
Son disponibles 10 menú remotos. A continuación se listan los parámetros del menú 1. los otros son análogos

Parámetro Descripción valores Por defecto Notas

hmiList_ID_1 listado iD navegación HMi remota 1 0 … 254 0

hmiList_Res_1 tipo recurso navegación HMi remota 1
1=RtU ( RS485 Modbus RtU)

2=tCP (Modbus tCP)
3=CAN (CANopen)

3=CAN

hmiList_Addr_1 Dirección recurso navegación HMi re-
mota 1 para CAN, RtH y tCP (iP parte 1)

0 … 255 0

ej. CAN : 2. 500000
ej. 485s : 1. 38400. P81
EtH: 010.000.000.100

hmiList_Addr_2 Dirección recurso navegación HMi 
remota 1 para tCP (iP parte 2)

0 … 255 0

hmiList_Addr_3 Dirección recurso navegación HMi 
remota 1 para tCP (iP parte 3)

0 … 255 0

hmiList_Addr_4 Dirección recurso navegación HMi 
remota 1 para tCP (iP parte 4)

0 … 255 0

hmiList_File_1 File navegación HMi remota 1 
(formato DOS 8.3 mayúsculas)

secuencia alfanumérica de 8 
caracteres

********
normalmente el nombre por 

defecto será
HMiREM.KBD
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CONEXIóN AL TARGET
Antes de la conexión abajo a la derecha del panel aparece el mensaje NOT CONNECTED
Desde el menú desplegable seleccione Communication > Connect

Si la conexión ha sido realizada con éxito en la barra de menús aparece la ventana (reducida a icono)

Dicha ventana permanece presente mientras el dispositivo  target sigue conectado. Para interrumpir la conexión repita el pro-
cedimiento Communication > Connect

Abajo a la derecha del panel hay una paleta de conexión dividida en 3 secciones
Antes de conectarse al target el panel muestra la falta de conexión

Cuando estamos conectados al target se dan varias situaciones, que mostramos a continuación

• CONNECTED (en verde): si la conexión se ha realizado y la aplicación del target coincide con la aplicación de Studio
• DIFF CODE (en amarillo): si la conexión se ha realizado y la aplicación del target No coincide con la aplicación de Studio

• CONNECTED (en verde): si la conexión se ha realizado
• NO CODE (en celeste ): si la conexión se ha realizado y no hay ningún aplicación en el target

• CONNECTED (en verde): si la conexión se ha realizado y la aplicación del target coincide con la aplicación de Studio
• SOuRCE Ok (en verde): si la conexión se ha realizado y la aplicación del target coincide con la aplicación de Studio

• ERROR (en rojo): si existe un error de comunicación

DOwNLOAD
Para descargar la aplicación basta con pulsar F5 o seleccione en el menú desplegable Communication > Download code

Aparecerán las siguientes ventanas de diálogo

A. En caso de que ya esté presente la aplicación se le pide la confirmación para sobreescribir la anterior versión
B. Mensaje de advertencia de que el PlC se reseteará (pondrá a cero) en el target

A                   B

  
Confirmando con ‘Sì’ la aplicación se descargará al target. El proceso podrá durar unos segundos: aparece la ventana de 
‘Download en progress’ para indicar el estado del download.

Si hay un error de conexión aparece la siguiente ventana de diálogo.
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Smart
A continuación se muestra el entorno de trabajo Device con pantallas y descripción para Smart. En los casos en 
que se considera necesario se muestran las diferencias correspondientes a Evolution.
El entorno de trabajo Device presenta varias secciones para la gestión de una aplicación iEC generada por un 
desarrollador, es decir la configuración de los parámetros de FREE Smart, tests, actualización de BiOS y descarga de aplicación 
al dispositivo target.
Nota: el código fuente de la aplicación No es visible desde el Device

A continuación el listado de las secciones (paneles):

Sección
Nombre Panel /

Sección

Application
Panel Descripción

A /

Barra de configuración 
(Configurator bar) 

 

Esta sección muestra los instrumentos de trabajo 
mediante iconos.
Para visualizar o no las barras de instrumentos basta con 
hacer click con la tecla derecha del ratón y seleccionar o 
deseleccionar los instrumentos deseados.

Algunos instrumentos se pueden seleccionar mediante 
combinaciones de teclas (shortcuts).  
Ver su correspondiente capítulo para más detalles.

DEFINICIONES PANELES DEvICE

CB

GF

A

h

E

D
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Sección
Nombre Panel /

Sección

Application
Panel Descripción

B Project Proyecto
El panel Project permite gestionar uno o varios 
dispositivos FREE Smart.

C / Edit panel

En este sección aparecen, en base a la selección del 
panel Project
• los parámetros BiOS (parámetros + valores i/O)
• los parámetros y las variables definidas por el 

desarrollador en  Application asociadas al menú

D Catalog Catálogo aplicaciones Este panel muestra todas las aplicaciones disponibles en 
el catálogo

E Connection 
Status

Este panel muestra el estado de conexión de todos los 
target presentes en el panel Project

F watch visualización de variables con 
aplicación ejecutándose

Este panel permite gestionar el test de las variables 
mediante la visualización de su estado en formato 
números/letras cuando la aplicación está ejecutándose y 
conectada al dispositivo target

G Oscilloscope visualización gráfica variables

Este panel (analogamente al panel watch) permite 
gestionar el test de las variables  mediante la visualización 
de su estado en formato gráfico cuando la aplicación 
está ejecutándose y conectada al dispositivo target

h* Output Mensajes

Esta panel muestra los mensajes correspondientes al 
desarrollo del proyecto (apertura de fichero, errores de 
lectura/escritura, estado de conexión al dispostivo etc.)
Nota: la conexión al dispositivo target es visible también 
abajo a la derecha de la pantalla mediante mensajes en 
color (ver Download Aplicación)

*panel no visible al primer arranque.  
Para visualizarlo basta con seleccionar en el menú desplegable view >  Output

los paneles aparecen o no (ver capítulo Shortcuts) y pueden organizarse por lo que respecta a su disposición y dimensión a 
gusto del  usuario.
Studio memoriza las últimas configuraciones realizadas.
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FIELD OPERATION

Smart
PRIMER ARRANQuE[1]

1. Haga click en el icono  Launch FREE Studio que se encuentra en el Escritorio
2. Haga click en el icono FREE Studio Device[2].

1 2

El programa se presenta como se muestra en la figura:

Ahora podemos:
• Crear un nuevo proyecto .CFN ‘New Project ...’[3]

• Abrir un proyecto existente ‘ Open project …’ 
• Abrir los proyectos recientes ‘Most recent projects ...’ seleccionándolos de un listado

los proyectos de Device tienen la extensión .CFN
En el mismo proyecto se pueden añadir varios 'drive' y asociar a cada 'drive' una aplicación iEC creada con Application

1 La herramienta Device está disponible para Smart. Todas las herramientas (incluyendo Device) están disponibles para Evolution. Para Evolution  
 le aconsejamos - para el primer  Arranque - empezar siempre con la herramienta Connection (ver correspondiente capítulo)
2 un proyecto puede abrirse con Device también desde la aplicación Application desde el menú desplegable Developer > Open 
 with FREE Studio Device
3 A un nuevo proyecto se le añade un 'drive' presente en el catálogo mediante click en tecla derecha del ratón seleccionando Add. ver pantalla  
 siguiente.
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Un nuevo proyecto untitled está vacío. Con la tecla derecha del ratón añada un nuevo 'drive' al proyecto 
existente presente en el catálogo seleccionando Add. 

APERTuRA DE LA APLICACIóN IEC

Del mismo modo se añade la correspondiente aplicación iEC PLC presente en el catálogo.
El catalogo puede contener distintas aplicaciones pero solo una puede asociarse a un proyecto
la aplicación iEC se añadirá al drive como nombre_1

Un proyecto existente se abre como ya se ha descrito o directamente desde Application:
mediante el menú Developer > Open with FREE Device se pondrá en marcha el Device que contiene el proyecto creado por 
el desarrollador con el entorno de desarrollo Application
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CONEXIóN AL DISPOSITIvO TARGET

Device presupone que nos tengamos que conectar de nuevo al dispositivo target (haga click en el correspondiente 
icono). El panel central muestra las referencias del protocolo, dirección etc. El nombre del dispositivo target es por defecto 
FREESmart_1[4].
Cuando el dispositivo target está conectado se pueden leer o escribir parámetros.

LECTuRA PARáMETROS[5] 

El proyecto contiene por defecto la lista de los parámetros BiOS y valores de i/O[6] con sus correspondientes valores por defec-
to. El usuario puede leer del target todos o solo algunos parámetros[7]

Supongamos que lee todos los parámetros.
Desde el menú desplegable Parameters>Read all device parameters se leen todos los parámetros del target conectado.
la operación requiere algunos segundos.

Si hay parámetros de configuración con valores por defecto distintos de los presentes en el target quedarán resaltados con un 
color (en azul[8])

ESCRITuRA PARáMETROS 

El usuario puede descargar al target todos o algunos parámetros con sus valores por defecto o con valores modificados por el 
usuario

Supongamos que desea descargar todos y solo los parámetros Cl (BiOS locales). 
Seleccione todos los parámetros - menú desplegable Parameters>Select all (CtRl+A) o mediante su correspondiente ico-
no. los parámetros quedan todos resaltados en amarillo.  Seleccione en el menú desplegable Parameters>write selected 
(CtRl+SHiFt+W) (o mediante icono w)
todos los parámetros Cl se descargarán al target[9].

4 Con un sencillo copiar-pegar se puede crear un proyecto gemelo FREESmart_2, modificar los parámetros de BIOS y descargarlos al target o  
 en un segundo target
5 En realidad en este caso por parámetro se entiende cualquier recurso presente en el dispositivo target es decir parámetros propiamente dichos,  
 I/O y variables de la aplicación presente en el target
6 Las entradas y salidas analógicas tienen valor por defecto 0.0; las digitales están configuradas como FALSE
7 Para leer un parámetro basta con seleccionarlo con el ratón y hacer click en el icono R. 
 Se permiten selecciones múltiples (tecla CTRL para selecciones no consecutivas, ShIFT para seleccionar una parte del bloque)
 Mediante el correspondiente icono se puede seleccionar el bloque completo. La selección se resalta mediante un fondo amarillo
8 ver tabla valores  parámetros
9 ver ejemplo desarrollo proyecto - capítulo específico. 
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Como se indica en las notas se pueden descargar también los valores de las variables de i/O configuradas por el usuario 
o por defecto. la descarga de todos los parámetros (menú desplegable Parameters>write all device parameters[10]) 
conlleva la sustitución de todos los valores presentes en el target por los valores presentes en la columna Value.
Nota: las entradas son solo de lectura y aparecen en color gris. Véase la siguiente tabla:

Tabla valores parámetros

Color Columna Descripción Casos

negro value valor alineado con default lectura del target ya realizada

azul default
valor columna default distinto 

de valor columna value lectura del target ya realizada

rojo value
valor No alineado con 

default
• Device recién abierto

• valor modificado por el 
usuario

gris name
parámetros solo de lectura 

(read only)

valores de i/O (i/O values)
entradas analógicas Ai 

y digitales De

verde name
parámetros no visibles en el 

display del target Ver tabla visibilidad

 
Al declarar las variables de estado y parámetros EEPROM en Application se puede definir su nivel de visibilidad en el menú 
target Smart[11] tal como se muestra en la imagen:

BIOS Download
Existe la posibilidad de actualizar el BIOS de Smart desde el Device. Seleccione el nombre del target y haga click con la tecla 
derecha del ratón. Seleccione BIOS download[12] y abra el fichero .fwf que desea descargar
la modalidad directa Direct se efectúa mediante DMI directamente en PC mientras que la modalidad MultiFunctionKey requie-
re el paso mediante la MFk y luego la descarga en Smart

Evolution
El menú BiOS por defecto de Evolution aparece visible en la carpeta All Parameters.
En la carpeta All Parameters se ven también los parámetros de usuario definidos con Application 
la descarga de la aplicación PLC y del menú hMI se realiza solo desde el Device pero se describe en el capítulo Connection 

Panel
El menú BiOS por defecto de EvP es visible desde la carpeta All Parameters. En la carpeta hMI management se ven los pará-
metros de gestión de las páginas HMi locales y remotas.
En la carpeta All Parameters también se ven los parámetros de usuario definidos con Application 
10 Si selecciona Parameters>write all default values en el target se descargarán todos los valores por defecto, incluyendo las I/O
11 Irrelevante en el Evolution
12 Consulte el manual instalación. BIOS Download no disponible mediante RS485. 
 No alimente Smart externamente (alimentar solo mediante DMI)
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DEFINICIONES PANELES uSER INTERFACE

Evolution  

El entorno de trabajo user Interface específico para desarrollador presenta varias secciones para la creación y 
gestión de páginas personalizadas, es decir, la definición de la interfaz gráfica de FREE Evolution, uso y creación de plantillas y 
descarga hMI al dispositivo target.

A continuación les mostramos el listado de las secciones (paneles):

Panel
El entorno de trabajo user Interface para EvP prevé que la creación y gestión de páginas y descarga hMI local se produzca en 
EvP.
la característica de EvP consiste en gestionar menús remotos de Evolution creados 
con userInterface.
los menús que el EvP utilizará como hMI remotos se crean expresamente como tales.
Ver Creación nuevo proyecto

A

CB

GF

D E

h
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Sección
Nombre Panel /

Sección

user Interface
Panel Descripción

A /

Barra de configuración 
(Configurator bar) 

 

Esta sección muestra los instrumentos de trabajo 
mediante iconos.

Algunos instrumentos se pueden seleccionar mediante 
combinaciones de teclas (shortcuts).  
Ver su correspondiente capítulo para más detalles.

B Project Proyecto

El panel Proyecto se subdivide en 2 pestañas:
• Project: permite gestionar las páginas que se 

visualizarán en los terminales gráficos de Evolution
• Resources: permite gestionar las imágenes, listas y 

secuencias que podrán utilizarse en las páginas

C Actions

En esta sección aparecen, dependiendo de la pestaña 
seleccionada:
• Local Actions
• Global Actions
las 'acciones' referidas a las teclas de la interfaz de 
Usuario

D Document bar Edit panel Este panel permite definir la gráfica de las páginas

E Properties visualización propiedades Este panel permite definir las propiedades de las páginas 
o de los elementos que la componen

F Output Mensajes
Esta panel muestra los mensajes correspondientes al 
desarrollo del proyecto (apertura de fichero, errores de 
compilación, etc.)

G Target vars & 
parameters

visualización de variables y 
parámetros del target

El panel se subdivide en 2 o varias pestañas:
• Target vars contiene las variables/parámetros BiOS 

de Evolution
• PLC vars contiene las variables/parámetros definidas 

en la aplicación PlC de Application residente en la 
base del Evolution donde será descargado l'hMI.

• Otras pestañas visualizan variables/parámetros con 
dirección Modbus a visualizar en la interfaz HMi. 
Nota: estas aplicaciones han sido descargadas 
mediante Studio a otros Evolution conectados en 
red al Evolution donde se descargará el HMi que se 
desea desarrollar

h Templates visualización plantillas 
disponibles

Este panel muestra todas las páginas creadas como 
'template' es decir como plantillas para volver a utilizar 
que permancen disponibles en el catálogo

los paneles son visibles o no al primer arranque.  
Para la visualización basta con seleccionar el correspondiente elemento en el menú desplegable. Ej. view > Templates
los paneles pueden organizarse, por lo que respecta a su disposición y dimensiones, a gusto del usuario.
Studio memoriza las últimas configuraciones realizadas.
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PARA INICIAR uSER INTERFACE

uSERINTERFACE vS CONNECTION

Como ya se ha indicado en el capítulo TARGET y como se ha descrito en el capítulo Connection la apertura de userInterface 
se lleva a cabo normalmente desde Connection haciendo click sobre el nodo HMi 
le aconsejamos por tanto que lea el capítulo Connection antes de desarrollar un menú en userInterface
Para efectuar los primeros pasos y crear un menú sencillo 'stand-alone'[1] se puede seguir el camino que les mostramos a 
continuación

PRIMER ARRANQuE

1. Haga click en el icono  Launch FREE Studio que se encuentra en el Escritorio
2. Haga click en el icono FREE Studio user Interface.

1 2

El programa se presenta como se muestra en la figura:

1 un menú creado de este modo queda enlazado ('linkado') a un proyecto Connection. ver correspondiente capítulo.

Panel • Evolution 
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Ahora podemos:
• Crear un nuevo proyecto ‘New Project ...’  - CTRL+N
• Abrir un proyecto existente ‘ Open project …’ - CTRL+O
los proyectos existentes tienen la extensión .pajx

CREACIóN NuEvO PROYECTO

• Haga click en New Project ... o
• desde el menú desplegable seleccione File > New Project (CTRL+N)

Aparece la ventana de diálogo siguiente donde se puede crear y guardar con nombre un nuevo proyecto:

Nuevo Proyecto Nuevo hMI remoto

El nuevo proyecto se presenta como se muestra en la figura:

• la descripción  de los iconos se encuentra disponible en el help en linea (Ayuda en línea, en inglés) - véase el capítulo 
Soporte

• la descripción de los paneles del entorno de desarrollo standard descrita con anterioridad se desarrolla en el presente 
capítulo

A continuación le mostraremos como crear, desarrollar y testar un nuevo menú con ejemplos sencillos de páginas, plantillas y 
programas sencillos.
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CREACIóN DE PáGINAS

En el panel Document bar se visualizarán todas las páginas creadas que compondrán el menú visible en el display del instru-
mento. A continuación se mostrarán en modo generico los elementos para crear las páginas  
En en Apéndice se mostrarán algunos simples ejemplos de menú que podrán utilizar para definir un menú básico que funcione.

PANEL PROjECT / PESTAñA PROjECT

En esta pestaña se puede utilizar los siguientes elementos (nodos):
• Pages para gestionar las páginas (creación, borrado, importación/exportación, etc)
• Messages para gestionar las páginas 'mensaje'
• Global variables  para gestionar las 'variables' comunes a todas las páginas
• Global procedures para gestionar los 'procedimientos' comunes a todas las páginas. Nota: los procedimientos se escriben 

en un solo lenguaje.

PAGES

Properties
Desde la pestaña Project, nodo Pages se puede, haciendo click con la tecla derecha en Properties editar las propiedades de 
las páginas[1] tal como se ha indicado:

General System options Language selection

1. Desde la tab General se puede elegir qual es la página inicial
2. Desde la tab System options se puede elegir el tipo de font[2], el color del texto y del fondo (2 opciones, blanco y negro)
3. Desde la tab Language selection se pueden gestionar los idiomas: 
 • con Select se selecciona el idioma actual (indicata en el box Current language), 
 • con Add se añade un nuevo idioma
 • con Delete se borra el idioma
 • con Export se exporta y importa el fichero texto .txt a traducir[3]

 • con Import se importa respectivamente el fichero de texto .txt traducido[4]

4. desde la tab Global On timer el desarrollador puede añadir procedimientos globales 'a tempo' creados específicamente

Creación páginas
Mediante el menú desplegable seleccione Project >Objects (insert page) o haga click en el correspondiente icono New Page 
Aparece una ventana donde puede introducir el nombre de la página[5]. la página creada aparece en la sección Document bar 
(donde se puede editar y modificar)
Nota: la página puede ser configurada como página de pop-up[6]

1 queste propiedades no son de la singola página ma comunes a todas las páginas
2 visible también desde la pestaña Resources > Fonts
3 también desde el menú desplegable Project > Export language to file...
4 también desde el menú desplegable Project > Import language from file...
5 el nombre de la página no ha de contenere spazi (ej. New Page da error; NewPage (sin spazi) o New_Page (con underscore) son nomi 
 accettati. Otros caracteres pueden no ser accettati (Es. /, <,>, etc)
6 en el display aparece siempre una página a la volta. una página de pop-up es una página que aparece en el display sopra un'altra página 
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Página inicial
Ha de asignarse obligatoriamente la propiedad de página 'inicial' (initial page)[7]

la página inicial puede ser la página utilizada para la 'visualización principal' es decir la página por defecto que aparece si no si 
opera en el instrumento. Por tanto se puede definir como visualización principal una imagen[8] (ej. logo o nombre de la em-
presa) o una página que visualice valores (ej. de temperatura, pulsación ,setpoint etc) importantes para mostrar a una primera 
lectura Nota: si no se selecciona la página inicial se producirá un error de compilación.

Gestión de páginas
Haciendo click con la tecla derecha del ratón será posible renombrar, copiar, borrar la página, etc.

Insert page New page

Messages
Desde el panel Project, haciendo click con la tecla derecha sobre el nodo Messages  y seleccionando Insert new message 
page  se crea una nueva página 'mensaje'[9]. 
las páginas de 'mensaje' son análogas alle altre páginas ma ciascuna riporta un ID univoco
A continuación un ejemplo de llamada de página “mensaje” y su correspondiente sintaxis. 
llamada desde un script user Interface: dummyboolean:=Video_SendEvent( kWM_MSg, MessageiD );
llamada desde un program Application: dummyboolean:=sysHmi_Message(MessageiD);

Página mensaje ej. albero páginas mensaje ejemplo página mensaje 1

Template
Desde el panel Project, haciendo click con la tecla derecha en una página se puede exportar una página (sufijo .pex) o selec-
cionando Export page as  template  se guarda una página como página 'plantilla'[10]. (sufijo .petx)
Desde el menú desplegable Project > Template management se pueden gestionar las plantillas añadiendo a la Template List 
páginas .petx. las páginas añadidas se visualizarán también en el panel Templates como librería y serán utilizables mediante 
drag & drop (arrastrar y soltar) en el proyecto seleccionando según el momento la plantilla deseada.

7 modificable da sección (nodo) Pages. La página inicial es contraddistinta por un icono stile 'play' (triangolo rojo).  
8 en gergo definida como 'splash' 
9 identificadas en el albero con un triangolo a fondo amarillo stile 'Avvertenza' (warning)
10 un template es un modelo o schema da compilar en base a un struttura predefinita
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Lista template Librería template Instancia página template

PANEL PROPERTIES 
Cada objeto que se diseña en la página tiene propiedades configurables con la pestaña Properties.
Dependiendo del objeto seleccionado de la Page bar en la pestaña Properties aparecen o no los elementos para la correcta 
gestión del objeto dentro de la página
la lista completa está documentada en la help on line. Aquí solo se listan los más utilizados.

PESTAñA PROPERTIES[11]

Cada página, indivdualmente, posee las propiedades que pasamos a enumerar:

Default Descripción Default Descripción

CharDimx 6 Define las 'guías' 
de la rejilla de la 

página
min(1,1) para 

colocar los objetos

title bar NO

introduce un 
encabezamiento 

de tamaño 
predefinido

CharDimy 8 Page border NO
introduce un borde 

de página

Font EWP2_8x16
dimensión 
caracteres

Caption *

define el 
contenido del 

encabezamiento 
(Title bar)

Back color 'white' Color del fondo Appearance Flat
define el borde de 

la página

text color 'black' color del texto

A cada modificación de estos campos le corresponde la aparición de un asterisco (*) cerca del nombre de la página.
Para guardar la modificación utilice siempre la tecla REtURN.

PANEL ACTIONS 
Este panel permite definir las 'acciones' asignadas a los teclas de Evolution para la navegación del menú en el display.
las acciones se subdividen en 
• Local Actions: acciones 'locales' específicas de la página en cuestión
• Global Actions: acciones 'globales' comunes a todas las páginas del menú/proyecto
las teclas de Evolution son 5: Right (dx), left (sx), Up, Down y Enter (tecla OK). Se puede asociar además una acción a la pulsa-
ción 'mantenida' de cada una de las 5 teclas[12] (identificada con el prefijo Long, ej. LongUp).

Además de las 4 teclas hay 10 teclas 'virtuales identificadas con vk_F1, ..., vkF10[13]

las teclas virtuales se asocian a un procedimiento escrito en lenguaje ST

11 No confundir con  el correspondiente elemento 'Properties' de la pestaña Project, sección (nodo) Pages
12 Se mantiene pulsada normalmente de 3-5 segundos
13 ver también manual userInterface (help On  Line)
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Por ejemplo deseamos configurar la hora del reloj RtC. Creamos la correspondiente página

 
A la página le hemos asociado una tecla virtual vk_F1 (Close) en las Acciones locales.
El procedimiento en lenguaje ST es el siguiente

sysClock_update := TRUE;
uint_ret := Video_SendEvent[14](kWM_KEY,kKEY_vk_F1);

Para introducir una acción (Action) haga click con la tecla derecha y seleccione Insert action. la acción seleccionada queda 
resaltada en amarillo. la selección de Remove action borrará la acción resaltada en amarillo 
A cada tecla (key) se le pueden asociar las acciones siguientes

Acción (columna Action) Descripción Notas

Call llamada de un procedimiento
para 'llamar' un procedimiento basta 
escribir en la columna Link el nombre 
del procedimiento a llamar

OpenPage abre una página
escriba en la columna Link el nombre de 
la página que ha de abrir

Close cierra la página
asociamos la correspondiente tecla. 
Nota: vuelve automáticamente a la 
página de inicio

NextField
se coloca sobre el siguiente valor de un 

campo

PrevField
se coloca sobre el anterior valor de un 

campo

Edit
permite 'Editar' es decir escribir un valor 

en un campo 

14 Las funciones estándar preconfiguradas como videoSentEvent, etc (se escriben a mano) se describen en el manual userInterface
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PARáMETROS APLICACIONES
Desde el Menú Project > Parameter management[15] se pueden conectar los parámetros de una aplicación desarrollada en 
Application 

Con Add Device se importa el fichero de parámetros (.parx) deseado. A cada set de parámetros se le puede asociar el direc-
cionamiento Modbus o EWDMi[16] o Modbus y CANOpen[17].
El set de parámetros se visualiza en su correspondiente pestaña en el panel Target vars and parameters

PESTAñA PROPERTIES/vARIABLE
Para utilizar la variable basta con 'arrastrarla' (drag and drop) desde la pestaña importada a la página[18]

la propiedades de la variable se identifican en la pestaña Properties/variable con la 'sintaxis @'
la variable se identifica como  @nombre del file[19].nomevariabile
Para modificarla basta seleccionar el campo variable y situándose en la casilla hacer click sobre los puntos suspensivos (...)
Aparece la ventana variable parameter selection que muestra los recursos disponibles para asociar a la casilla
Nota: del mismo modo se puede crear una casilla 'progress' y asociarle una variable. En este caso en lugar del valor de la varia-
ble se ve el estado / barra gráfica de progreso de la misma.

vARIABLES PLC
Nota. Válido solo para proyectos con dispositivo target EVD/EVP
El target HMi remote soporta solo la sintaxis @ para la utilización de parámetros/estatus variables del correspondiente proyecto 
Application.

Desde Menú Project >Link PLC variables file se pueden conectar las variables de una aplicación PLC desarrollada en Appli-
cation 

Se importará el fichero 'ExP variable' (.exp) deseado. El set de parámetros se visualiza en la correspondiente pestaña PLC vars 
en el panel Target vars and parameters

15 O con el correspondiente icono Parameter management
16 Smart
17 Evolution
18 Como alternativa desde el menú Page>New Edit introduzca una casilla a la que asociar la correspondiente variable
19 Sin extensión  (ej. freeEvolution_1.plc, .plc no se visualizará)

Nota. 
• id=0 está reservado para EVK1000 o link entre 

un proyecto userInterface y Application resi-
dentes en el mismo hardware

• id≠0 que se configura en caso de una conexión 
a dispositivo externo (es decir, visualización de 
datos provenientes de otro dispositivo, es decir 
un hardware distinto del dispositivo target don-
de se ejecuta userInterface)
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GENERACIóN DE DOCuMENTACIóN

Mediante el icono Generate Doc. se crea la documentación referida a los campos Doc (panel Properties, tab Doc)

Mediante un navegador[20] se puede visualizar la documentación generada haciendo click sobre el link Open documentation.
la documentación contiene toda la información del proyecto:
• número de páginas
• idiomas del programa
• página inicial (nombre de la página inicial)
• listado visual de las páginas (como aparecen en el display)
Ejemplo de documentación generada mediante el icono Generate Doc. 

20 Internet Explorer y equivalentes
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PANEL PROjECT / PESTAñA RESOuRCES
En esta pestaña se pueden utilizar los siguientes elementos (nodos):
• Fonts para gestionar las páginas (creación, borrado, importación/exportación, etc)
• Bitmaps para gestionar las imágenes que se introducen en las páginas
• String table para gestionar las 'secuencias' que se utilizan en las distintas páginas
• Enumeratives para gestionar conjuntos 'numerables' que se utilizan en las distintas páginas
• Image lists
• Sets para gestionar 'set' de 'secuencias' / parámetros que se utilizan en las distintas páginas

Bitmaps
userInterface permite importar imágenes (bitmaps , como iconos, logos etc) para utilizarlas en las páginas del menú.
Haga click desde el nodo Bitmaps > Import bitmap. Aparece la correspondiente ventana para importar imagen. Seleccione 
mediante la tecla browse y realice la importación con la tecla import. Ejemplo de importación del logo free

le aconsejamos importar imágenes en blanco/negro con una dimensión coherente. El display puede soportar una imagen 
100x50px aprox. El bitmap importado se encontrará en el nodo Bitmaps[21]

Para introducir el bitmap en una página:
• introducir una casilla 'imagen' (menú Page > New image o mediante el correspondiente icono)
• definir las dimensiones de la imagen desde el panel Properties mediante XDim y YDim (ej. 100x50px)
• igualmente, desde el panel Properties seleccione el bitmap del campo del mismo nombre.

String table
userInterface permite definir 'secuencias' (strings) que podemos utilizar en la creación de las páginas.
Mediante el menú String>Insert o con el correspondiente icono Insert Record se puede crear una asociación[22] entre una 
'secuencia' y su correspondiente descripción. 
En el campo ID se define la secuencia como IDS_nomestringa. [23]

En el campo Caption se introduce la descripción.

21 Si no se renombra, como nombre por defecto aparecerá el nombre de la imagen precedida por el prefijo bmp (ej. logofree-> bmplogofree)
22 En jerga 'transcodificación'
23 Le aconsejamos utilizar este prefijo para no confundir las descripciones que aparecen en el display con la transcodificación en userInterface
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Desde el menú Project/Project seleccionando la página se puede asociar mediante el menú Properties>Caption la secuencia 
deseada a  un campo de texto[24]. El texto que aparecerá en el display será el que se defina en la descripción[25] 

Enumeratives
userInterface permite además definir las 'secuencias' mediante conjuntos 'numerables' que se pueden utilizar para la creación 
de las páginas.
Un conjunto numerable es un 'vector' de valores no necesariamente consecutivos. A cada valor se le asocia una descripción 
que se visualiza en el display del Evolution. 
Situándose sobre el nodo Enumeratives y mediante el menú Record>Insert o con el correspondiente icono Insert Record se 
crean los conjuntos a utilizar[26] 
Cada conjunto se visualizará como subnodo de Enumeratives. 
Situándose sobre el correspondiente nodo y mediante el menú Record>Insert o con el correspondiente icono Insert Record 
se introducen los valores del vector. 
tras haber creado (es decir definido) el enumerativo en la pestaña Resources, se pasa a la pestaña Project y, seleccionando la 
página / elemento de la página deseada, tendremos que asociar al campo Format el correspondiente Enum
En los tres ejemplos puede apreciarse: 
• definición de un enumerativo CelFarEnum de 2 valores para definir los grados de temperatura (0=Celsius, 1=Fahrenheit). 
• definición de un enumerativo de 4 valores no consecutivos para definir comandos USB (valores 8,9,10,12)
• uso de CelFarEnum en una página

El orden de los elementos se puede modificar con los iconos Move up s / Move Down t

Definición de CelFarEnum Enum con valores no consecutivos uso de CelFarEnum

Image Lists
igual que con los Enum se pueden crear 'listas' de imágenes asociadas a 'rangos' de valores. la imagen que aparece en el 
display se modificará dependiendo del estado de la variable asociada a la lista.
Se crea la lista y se asocia a cada imagen un bitmap (ver correspondiente nodo) indicando el rango de referencia.
tras haber creado (es decir definido) la lista en la pestaña Resources, se pasa a la pestaña Project y, seleccionando la página / 
elemento (creado con 'New animation') de la página deseada, se tendrá que asociar al campo imagelist la lista de bitmap
En los tres ejemplos puede apreciarse: 
• definición de una lista Modeimg de 2 bitmaps para visualizar el modo Cool y el modo Heat. El rango de valores se reduce 

a un valor, en este caso (0 para cool, 1 para heat)
• uso de Modeimg en una página 'icons' asociando a la animación la lista Modeimg. Se le asocia naturalmente una variable  

de estado en función de la cual cambiará la imagen.
Un bitmap 'estático' se introduce como imagen mediante Page > New Image o mediante su correspondiente icono.

24 En realidad se pueden asociar también imágenes pero aquí por simplificar hablamos solo de campos de texto.
25 Si el campo Descripción está vacío aparece la secuencia IDS_xxx
26 Por defecto el nombre es Enum1, Enum2, etc. Situése sobre la casilla para cambiar el nombre.
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Definición de ModeImg uso de ModeImg

Sets
A menudo existe la necesidad de crear un grupo de páginas muy similares entre ellas (por ejemplo un menú con desplaza-
miento para visualizar un conjunto de parámetros de una misma carpeta)
userInterface permite definir conjuntos 'Sets' que se pueden utilizar para la creación de páginas de este tipo sin tener que 
replicar la página n veces.
Un Set es un 'vector' de secuencias o variables/parámetros[27]

Situándose sobre el nodo Sets y mediante el menú Record>Insert o con el correspondiente icono Insert Record se crean los 
conjuntos que se han de utilizar[28] 
El tipo del Set puede ser 
• String es decir una 'secuencia' definida en String table
• variant es decir una 'variable/parámetro'

Cada conjunto se visualizará como subnodo de Sets. 
Situándose en el correspondiente nodo y mediante el menú Record>Insert o con el correspondiente icono Insert Record se 
introducen nuevos items del vector 

Strings
En el caso de un Set de tipo String la selección de la secuencia se realiza situándose sobre la casilla y haciendo click sobre los 
puntos suspensivos (...)
Aparece la ventana Resource string selection que muestra las secuencias disponibles[29] para asociar al vector.
la visibilidad (columna visible) para las secuencias es tRUE - no modificable.

variant
En el caso de un Set de tipo variant la selección de la 'variable'[30] se realiza de igual modo, situándose en la columna varia-
ble/Parameter
Aparece la ventana variable/parameter selection que muestra las 'variables' disponibles para asociar al vector

27 Incluyendo posibles alarmas
28 Por defecto el nombre es Set1,Set2, etc. Situése sobre la casilla para cambiar el nombre
29 Definidas anteriormente en la string table (ver)
30 Por 'variable' en este caso se entienden las variables propiamente dichas, parámetros PLC, BIOS, alarmas etc
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Mediante la opción Filter se puede 'filtrar' la visualización de las variables/parámetros

• la columna Format visualiza la U.M. por defecto del parámetro. El usuario puede asociar manualmente un Enum
• De igual modo las columnas Min Max visualizan el rango por defecto del parámetro modificable por el usuario[31]

• la columna Text align alínea la secuencia a la derecha, izquierda o centrada

tras haber creado el Set desde la pestaña Resources, se pasa a la pestaña Project
Anteriormente si se ha creado una página que se desea 'replicar' utilizando los Set
(por ejemplo para la gestión de las salidas Analógicas BIOS_CFG_AO)
Seleccionando el correspondiente campo se tendrá que asociar al campo Assoc_var el correspondiente Set utilizando el prefi-
jo #,  y como sufijo (0) para indicar el primer elemento del vector. Nota: El campo ha de ser de tipo Edit
(por ejemplo para la gestión de las salidas Analógicas #SetParvalCfgA0(0))

En los tres ejemplos se ve:
• definición de un Set Variant SetParvalCfgA0 de dimensión 5 para definir vector de los parámetros de configuración de las 

salidas analógicas  
• definición de un enumerativo AnaOutTypeEnum de 3 valores (tensión, corriente, ON/OFF)
• uso de #SetParvalCfgA0(0) en una página (que produce como resultado 5 páginas que difieren según la configuración 

del parámetro SetParvalCfgA0(1),..., SetParvalCfgA0(5)[32]

• téngase en cuenta que el campo Edit 'iO Modulated' está asociado mediante el campo Format al Enumerativo AnaOutT-
ypeEnum

téngase en cuenta que en el ejemplo hay otro campo Edit asociado a un Set. 
Es posible utilizar varios Set en la misma página
 le aconsejamos que defina Set de la misma dimensión si se usan en la misma página.

SetParvalCfgA0 AnaOutTypeEnum uso de #SetParvalCfgA0()

31 Ej. En un parámetro que define un Modo de máquina COOL, hEAT y AuTO se pueden ocultar uno o varios valores a nivel uI aunque a nivel  
 PLC (es decir Application) haya 3 modos de utilización
32 Téngase en cuenta que el vector parte del valor (0), mientras que en la definición de Set el primer valor es 1 por tanto Set(1) corresponde a #Set(0)
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DEFINICIONES PANELES CONNECTION

Panel • Evolution
Como se indica en los capítulos anteriores Connection es el punto de partida para empezar a desarrollar los 
proyectos
El entorno de trabajo Connection define la estructura hardware de un proyecto Evolution y gestiona los protocolos de red e 
intercambio de datos entre Evolution (binding)

El entorno de trabajo Connection , específico para el desarrollador, presenta varias secciones para la creación y gestión de 
dispositivos Evolution[1], y la compilación de todo el proyecto,es decir, como se indica en la sección Target 
• la creación de la aplicación PLC mediante Application
• la definición de la interfaz gráfica de Evolution mediante userInterface
• la compilación del proyecto Build project
• la descarga del proyecto mediante Device

A continuación le mostramos el listado de las secciones (paneles):

Sección
Nombre Panel /

Sección

Application
Panel Descripción

A /

Barra de los instrumentos 
(Main bar) 

 

Esta sección muestra las herramientas de trabajo 
mediante iconos.
Algunas herramientas se pueden seleccionar mediante 
combinaciones de teclas (shortcuts).  
Ver su correspondiente capítulo para más detalles

B Project Proyecto (workspace)

El panel Project permite gestionar el proyecto y uno o 
varios dispositivos Evolution*
• desde el proyecto se puede gestionar la red 

(Network list) de dispositivos 
• Dentro de cada dispositivo (device) se configuran los 

distintos protocolos - ver panel C

1 Incluyendo Panel (EvP) y terminal Evk1000. Por Evolution se entiende EvD con display, EvC (no display)

A

B
C D

E
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Sección
Nombre Panel /

Sección

Application
Panel Descripción

C / Configuration panel
(Edit)

En esta sección aparece
• pestaña General gestión proyectos
• pestaña Network list gestión redes

Dependiendo de la selección del dispositivo Evolution 
• pestaña General configuración Evolution
Dentro del dispostivo (ej. Evolution EvD)
• PLC configuración de la aplicación iEC desarrollado 

con Application
• hMI configuración menú user Interface
• CANopen configuración correspondiente protocolo
• RS485 configuración correspondiente protocolo
• Plugins configuración protocolos mediante plug-in

D Catalog Catalogo dispositivos
Este panel muestra todos los dispositivos disponibles en 
el catálogo. Nota. Visibilidad dinámica de los dispositivos 
dependiendo de las selecciones (ej: plugins)

E Output Mensajes

Esta panel muestra los mensajes correspondientes al 
desarrollo del proyecto (apertura de fichero, errores de 
lectura/escritura, estado de conexión al dispostivo etc.)
Nota: la conexión al dispositivo target también es visible 
abajo a la derecha de la pantalla mediante mensajes en 
color (ver Download Aplicación)

*Connection gestiona uno o varias Evolution (EvD, EvC, terminal Evk1000) y EvP
Smart puede introducirse en la red como dispositivo slave mediante RS485
la expansión EvE puede introducirse en la red como dispositivo slave mediante RS485 o CANOpen
la visualización de los paneles es configurable desde el menú desplegable view > nombre panello y pueden organizarse 
por lo que respecta a su disposición y dimensiones a gusto del usuario.
Studio memoriza las últimas configuraciones realizadas.

El panel  view > Compiler toolbar  es un icono visible o no desde el menú Main

Configuration panel (Edit)
Se muestran los varios device / nodos por defecto disponibles para los varios target. los device para EvD se indican en la 
tabla anterior sección C
EvD EvP EvC y Evk son devices disponibles como nodos 'root' del proyecto (ver apartado Panel Project). 

EvP Panel
• PLC 
• hMI
• CANopen
• RS485
• Ethernet
Téngase en cuenta que no hay 
plugins Ethernet a bordo

EvC 
• PLC 
• hMI Remote
• CANopen
• RS485
• Plugins
Téngase en cuenta que hMI es de 
tipo remoto

terminal Evk
• CANopen
Téngase en cuenta que el único 
protocolo disponible es el CANOpen
No hay plugins presentes
PLC y hMI se heredan del Evolution
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PARA INICIAR CONNECTION

Panel • Evolution 

PRIMER ARRANQuE

1. Haga click en el icono  Launch FREE Studio que se encuentra en el Escritorio
2. Haga click en el icono FREE Studio Connection.

1 2

El programa se presentará tal como se muestra en la figura:

En este momento podemos:
• Añadir un nuevo dispositivo (device) al proyecto
• Añadir /quitar una red desde la lista network (Network list) 
los proyectos existentes tienen la extensión .con

CREACIóN NuEvO PROYECTO (wORkSPACE)
Para crear un nuevo proyecto, basta simplemente guardar el proyecto Untitled[1] renombrándolo a su gusto (CTRL+S) 
Para añadir un dispositivo al proyecto haga click en Add new device to the project[2] o simplemente arrastre (drag and drop) 
el icono de FreeEvolution desde el panel Catalog sobre el nombre del proyecto.
1 Al guardar el proyecto se crea en su PC una nueva carpeta con el nombre preseleccionado que sirve de workspace
2 O desde el menú Project, tecla derecha en untitled (o nombre de proyecto si ya está guardado) > Add 
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Ejemplo Add (Device)

le aconsejamos renombrar cada Evolution con un nombre adecuado (por defecto FreeEvolution1, FreeEvolution2, etc)
En el workspace se ve el nombre del dispositivo y la versión (version)[3]

creación nuevo proyecto CTRL+S añadido Evolution al proyecto
Téngase en cuenta ejemplo añadido de 2 Evolution

Catálogo de dispositivos

3 En el catálogo pueden haber más Evolution con versiones distintas (para visualizar todas las versiones 
 menú Options > Show all versions en catalog o mediante la casilla de chequeo  cuando aparece la ventana de diálogo)
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ejemplo EvD + 2 terminales Evk

los dos terminales keyboard EVK se conectan ambos al nodo CANOpen

 Nodo CANOpen canali virtuali 
channel1:124;  channel2: 123

canali virtuali 
channel1:124;  channel2: 123

El nodo CANOpen prevé por defecto 2 canales 'virtuales' para conectar como máximo 2 terminales EVK1000
Por defecto los canales virtuales son 124 para el primer terminal y 123 para el segundo terminal EVK1000
En todo caso basta con clicar en ? desde el nodo CANOpen para visualizar sus valores. 

Por defecto el terminal Keyboard EVK_1 tiene como dirección 127, canal virtual 124 y baudrate CanOpen 500Kb/s
Por tanto conectando físicamente un terminal EVK1000 con las configuraciones por defecto a un EVD es suficiente con cargar 
HMi remote desde el menú BiOS del EVK.
En caso contrario, por ejemplo con un Keyboard EVK_2 (que tiene como dirección 126) hay que configurar desde el menú BiOS 
del EVK la dirección 126 y el canal virtual 123.
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PANEL PROjECT
Cada Evolution dispone de los siguientes recursos visualizados como 'nodos' del target

target ambiente de 
trabajo descripción qué hacer Notas

EVD
EVC
EVP

PlC proyecto PlC
situése sobre el nodo y haga 
click con la tecla derecha del 
ratón para abrir Application

ver capítulo Para iniciar 
(Application)

EVD
EVP

HMi
menú para la creación de las 

páginas 

situése sobre el nodo y haga 
click con la tecla derecha 
del ratón para abrir user 

Interface

ver capítulo Para iniciar (user 
Interface)

EVD
EVC

HMi remote
menú para la creación de las 

páginas 

situése sobre el nodo y haga 
click con la tecla derecha 
del ratón para abrir user 

Interface

ver capítulo Para iniciar (user 
Interface)

target device descripción cosa fare Notas

EVD
EVC
EVP
EVK

CANOpen*
serial Evolution

a bordo (on board) de serie

seleccione el modo (Mode) y 
añadael dispositivo desde el 

catálogo

siempre disponible

EVD
EVC
EVP

RS485*

serial Evolution
on board de serie modelos 

EvD7500 y expansiones 
EvE75xx

comprobar disponibilidad

EVP Ethernet comprobar disponibilidad

EVD
EVC

Plugins**
módulos opcionales que se 

compran por separado
comprobar disponibilidad

* disponibles también como seriales en módulo plug-in
**es plug-in Ethernet

tanto PLC como hMI pueden ser creados desde cero o se pueden importar proyectos pre-existentes y desde el catálogo 

Proyecto PLC
Desde el panel Project > nodo PLC haga click con la tecla derecha del ratón y seleccione Open with Free Studio Application
Por defecto se le pedirá que guarde el proyecto FreeEvolution_n_PLC
Ver capítulo Application para el desarrollo. Resumiendo:
• desarrollar el código PlC con Application
• crear parámetros y variables de estado de la aplicación PlC
• compilar, descargar aplicación en el Evolution y realizar una eventual depuración 
• cerrar Application y volver a Connection
El proyecto guardado .ppjs se encuentra en la carpeta / workspace de Connection 

Proyecto hMI
Desde el panel Project > nodo PLC haga click con la tecla derecha del ratón y seleccione Open with Free Studio userInterfa-
ce
Por defecto se le pedirá que guarde el proyecto FreeEvolution_n_hMI
Ver capítulo user Interface para el desarrollo. Resumiendo:
• desarrollar el menú, es decir, las páginas hMI con userInterface
• los parámetros y las variables de estado de la aplicación PLC anteriormente creado se enlazan al menú y aparecerán en la 

sección h de userInterface Target vars & parameters
• comprobar la modalidad de conexión configurando debidamente los parámetros de conexión
• compilar, descargar al Evolution las páginas hMI
• cerrar userInterface y volver a Connection
El proyecto guardado .pajx se encuentra en la carpeta / workspace de Connection 
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El dispostivo se añadirá a una lista (se resalta en color amarillo)
Pulse la tecla Reload Device List  para llenar la tabla con el listado de los dispositivos conectados al proyecto hMI y para po-
der, si fuera necesario, usar las páginas remotamente.

Proyecto hMI Remote
Análogo a Proyecto HMi

PLC Configuration
añadido proyecto existente

hMI configuration 
añadido proyecto existente y Reload lista dispositivos

Download proyecto 
Mediante el menú Tools>Build o con F7 se crea el fichero de configuración .CFN
Desde el panel Tools > Open with Free Studio Device se abre Device
Una vez configurado el dispositivo, es decir los parámetros BIOS de comunicación, será posible descargar:
• aplicación PLC
• páginas hMI
• fichero de configuración Cfg files
mediante la tecla Download All
Nota: cada uno de los 3 ficheros puede ser descargado independientemente de los otros dos. situándose sobre el correspon-
diente icono, haciendo click con la tecla derecha del ratón y ejecutando la correspondiente descarga (download).

GESTIóN DE PROTOCOLOS

Cada protocolo puede utilizarse de varios modos.
Si el Mode aparece como Not used significa que su correspondiente device no está siendo usado.

target CANOpen RS485 Ethernet Profibus

EVP Master (for field)
Master 

(for HMi remoting 
and binding)

Modbus Master 
(for HMi remoting 

and field)

Enable Modbus Master 
(for HMi remoting and 

binding)
-

EVD
EVC

Master (for field) Slave (for binding)
Modbus Master 

(for field)
- DP Slave-V0

EVK
Master 

(for HMi remoting)
- - - -

Para las configuraciones (settings) consulte la Ayuda en línea (pulsando F1)

En el catálogo se visualizarán todos y solo los dispositivos que se pueden añadir ('colgar' con drag and drop) al correspondien-
te protocolo.
En el caso Slave y Ethernet se añade el dispositivo 'Binding'. Para añadir un source device' se selecciona la red (network)
El número máximo de dispositivos que se pueden añadir al nodo es comprobado por el Studio y señalado con el correspon-
diente mensaje. (Ej. máximo 2 Evk en CANOpen).[4] 
En el protocolo RS485 se pueden conectar también dispositivos genéricos Modbus

4 véase también manual de Instalación FREE Evolution y FREE Panel
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DEFINICIONES PANELES SIMuLATION

Smart Evolution
El entorno de trabajo Simulation, específico para desarrollador, presenta varias secciones para la ejecución 
simultánea de aplicaciones y páginas (Evolution) en un entorno de simulación sin la necesidad de un dispositivo 
target conectado al PC.
Simulation puede simular la ejecución de  
• aplicación PLC realizada mediante Application
• interfaz gráfica hMI de Evolution realizada mediante userInterface
la ejecución por tanto puede realizarse en el mismo PC que se ha utilizado para su desarrollo. 
la aplicación IEC puede ser 'descargada' en el Simulador en vez de descargarla en el target "físico".

le aconsejamos lanzar Simulation desde Application 

A continuación aparecerá el listado de las secciones (paneles) tal como se ve en la primera pantalla (empty workspace)[1]

En tal caso es necesario conectar al Simulador manualmente la aplicación IEC y/o las páginas hMI[2]

1 Respecto a los otros entornos de trabajo (Application, userInterface etc) no es indispensabile interactuar con la ventana de Simulation. Si no se  

 utiliza puede minimizarse con la tecla  
2 Solo Evolution

A

C

E

F G

D

B
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Sección
Nombre Panel /

Sección

Simulation
Panel Descripción

A / Barra de herramientas 
(Main bar) 

Esta sección muestra los instrumentos de trabajo 
mediante iconos.
4 para lanzar la Aplicación iEC (PlC)
 para detener la Aplicación iEC (PlC)

 Show hMI window
para visualizar/ocultar HMi (instrumento virtual)

 Show I/O panels
para visualizar/ocultar las ventanas i/O
 

 Show full control window 
para reducir /expandir la ventana

B workspace Entorno de trabajo 

fichero con el nombre preseleccionado que sirve de 
entorno de trabajo (workspace) 
Se pueden crear más workspaces con diferentes 
aplicaciones (Smart+Evolution) y/o páginas HMi 
(Evolution)

C Target name nombre del Target

Nombre del target no modificable por el usuario. 
Ejemplos:
• FreeSmart 412.5 para target Smart
• FreeEvolution423.5 para target Evolution
Nota compruebe desde Application >Project > Select 
target que el nombre del target dispone de una versión 
mayor o igual a 5 (ej:  FreeEvolution423.5). 

D PLC Project nombre aplicación PLC si el campo está vacío desde Edit > Edit workspace 
haciendo click sobre los puntos suspensivos (…) se 
selecciona el correspondiente fichero.E hMI Project nombre  páginas hMI

F I/O panels paneles I/O gestión de las ventanas de i/O

G Output window mensajes -

Edit workspace[3]

Desde Edit > Edit workspace haciendo click sobre los puntos suspensivos (…) se selecciona
• Target name: fichero que contiene tods la información para reconstruir el runtime del target (real) file .TGSX[4]

• PLC Project: aplicación IEC (PlC)  file .PPjS / .PPjX 
• hMI Project:  páginas hMI file .PAjX
 

aplicación IEC PLC
ya presente

selección páginas hMI
 .PAjX

3 Edit de tipo manual. Abriendo Simulation desde Application no es necesario 'editar' el entorno de trabajo 
4 El fichero .TGSX se crea de manera automática desde Application en la carpeta de FREE Studio > Catalog > FreeEvolution >Simulation
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SIMuLATION

Evolution
PRIMER ARRANQuE[1]

1. Haga click en el icono  Launch FREE Studio que se encuentra en el Escritorio
2. Haga click en el icono FREE Studio Simulation.

1 2

El entorno de trabajo (vacío) se presenta como se muestra en la figura 2

Ahora ya puede:
• Crear un nuevo proyecto (Area de trabajo workspace) .wkSX ‘New ...'
• Abrir un proyecto existente ‘ Open …’  CTRL+0
• Abrir los proyectos recentes ‘Recent file ...’ seleccionando de un listado

los proyectos (Area de trabajo, workspace) de Simulation tienen la extensión .wkSX

APERTuRA SIMuLATION DESDE APPLICATION[2]

Como alternativa, en el entorno de trabajo Application haga click en el correspondiente icono Simulation Mode[3]

1 2

1. Aparece una ventana de diálogo donde puede:
• Crear un nuevo workspace 
• Abrir un workspace existente (.wkSX)

2. Haga click en OK. Aparecerán: 
• el panel Simulation[4]

• conexión tCP/iP[5]: conexión local entre los entornos de desarrollo Application y Simulation

En Application basta con clicar en Download code para 'descargar' la aplicación iEC al Simulador

1 La herramienta Simulation está disponible para Smart y Evolution. Aconsejamos abrir Simulation directamente desde Application. ver apartado siguiente
2 Aconsejamos abrir Simulation directamente desde Application. Disponible para Smart y Evolution. 
3 Funcionamiento toogle. haciendo click en el icono Simulation mode se abre  / se cierra el entorno de trabajo Simulation
4 Si Simulation no se ejecuta es necesario cambiar el target. ver sección Troubleshooting
5 Reducida a icono en la barra de herramientas.
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En el panel A[6] hay dos iconos con los que se visualizan las correspondientes ventanas 
• Show IO windows ventanas que indican el estado de i/O
• Show hMI window representación gráfica e interactiva de Evolution 

Véase el ejemplo para un target Evolution

IO panels

Haciendo click en el correspondiente icono  aparecen varias ventanas/ventanas correspondientes a las entradas/salidas.

I/O panels Analog signal properties

la ventana I/O panels es una ventana 'índice' que lista todas las ventanas (visibles si la casilla  está seleccionada)
Desde esta ventana se puede añadir una ventana o eliminar/renombrar las ventanas listadas.
Para añadir una variable basta con 'arrastrar' desde Application a una o varias ventanas el elemento a monitorizar. las entradas 
y las salidas analógicas[7] son todas simulables:
En las entradas hay un cursor para modificar el valor leído.
Para las salidas existe una barra de estado / progreso. Para las digitales, estará en verde si no está activa la salida, roja si está 
activa. los otros elementos que se pueden simular son[8]

• Global shared
• Target variables
Nota. también se incluyen los parámetros BiOS y parámetros EEPROM[9]

6 La descripción completa está disponible en el manual Simulation. Pulse F1 para visualizar el pdf
7 Para I/O digitales ver hMI window
8 En general cada objeto que posee una dirección Modbus
9 Solo Evolution
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Cada elemento presente en las distintas ventanas tiene propiedades que puede editar mediante el icono 

Signal Properties

Desde esta ventana se pueden visualizar/ modificar
• Signal label : etiqueta de la  variable / recurso
• variable name : no modificable. indica el nombre presente en el código iEC
• Read only si la casilla  está seleccionada la variable es solo de lectura
• Min value / Max value: los recursos tienen el rango configurado por defecto. Manualmente, seleccionando la casilla , se 

puede definir / reducir el rango que se visualizará.

hMI window

Haciendo click en su correspondiente icono aparecerá la representación visual del target Evolution (instrumento virtual)

hMI window

Desde esta ventana se puede simular el estado de las entradas y de las salidas digitales
Si la salida está activa se colorea en rojo
los parámetros EEPROM se pueden resetear con la tecla Rst E2
Además, podemos navegar por el menú con las teclas del instrumento virtual como si operásemos con el dispositivo físico.

APERTuRA SIMuLATION DESDE uSERINTERFACE[10]

idéntico a Application. Haga click en el correspondiente icono Simulation Mode[11]

Smart
El ejemplo para un target Smart es análogo en todo.

10 Le aconsejamos que abra Simulation directamente desde Application. Disponible para Smart y Evolution. 
11 Funcionamiento toogle. haciendo click en el icono Simulation mode se abre el entorno de trabajo, clicando otra vez en Simulation lo cierra
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SOPORTE ELIwELL

SOPORTE TECNICO ELIwELL

Eliwell pone a su disposición personal técnico profesional y preparado para garantizar respuestas precisas y fiables a sus clientes. 
Nuestros técnicos están a su disposición cotidianamente para responder a las necesidades técnicas de la instalación y la utiliza-
ción de todos los instrumentos Eliwell. 

Para cualquier pregunta o para obtener soporte, contacte con nuestro soporte de programables Eliwell:

tel.  +39 0437 986 250
EMail:  eliwell.freeway@invensys.com

Antes de contactar con el Soporte tecnico de Eliwell le rogamos que compruebe la versión software de Eliwell FREE Studio.
Desde el menú desplegable seleccione help > About
Aparecerá la siguiente pantalla[1]:

Comunique la Versión (version) del software, el Build y la iD del Ordenador.

AYuDA EN LINEA

En cada fase del desarrollo del programa pulsando la tecla F1 se abre un documento pdf que contiene toda la ayuda en línea 
imprimible 

PR
O

G
R

A
M

M
A

B
LE

 C
O

N
TR

O
LL

ER
S

STUDIO

Development software for free Smart

The software solution in an integrated suite for quick, easy programming Help On Line

FREE Studio proporciona a los desarrolladores Ayuda en línea para dar asistencia el programador en cada fase del desarrollo 
del programa

1 Ejemplo en Application. Para Device la pantalla es análoga. Para los usuarios de Evolution análogas pantallas para userInterface y Connection

tel.  +34 96 313 40 49 

EMail:  freeway@eliwell.es
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AYuDA EN LINEA - LED[2]

Desde el panel Project>Resources>help se accede a la sección LED reference for the developer[3] donde se describen las 
características de los iconos de FREE Smart y su gestión mediante la target variable sysLocalLeds[])

SITIO wEB áREA RESERvADA
Nuestra página web en internet www.eliwell.it Eliwell dispone de un Área Reservada de acceso exclusivo con Contraseña.
los usuarios, una vez acreditados para su acceso al área reservada con Nombre de Usuario y Contraseña personales, podrán 
visualizar documentos, información, actualizaciones de producto y software de carácter reservado no visibles abiertamente en 
la web.

Haga click aquí para visitar la correspondiente página del sitio y tener todas la información necesaria para su inscripción.

la documentación de FREE Studio está disponible para usuarios registrados en la sección Aplicaciones > Programables > 
FREE wAY > FREE Studio

las actualizaciones del software están disponibles para usuarios registrados en la sección Soporte Tecnico > Area Programa-
bles > FREE wAY > FREE Studio

las aplicaciones y librerías están disponibles para usuarios registrados en la sección Soporte Tecnico > Area Programables > 
FREE wAY > FREE Studio > FREE Aplicaciones

2 Disponible solo para Smart
3 ver pantalla visualizada a pantalla completa (full screen, CTRL+u)

http://www.eliwell.it
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TROuBLEShOOTING
A continuación se muestran algunos casos de mensajes de error y las correspondientes soluciones del problema.
Para casos no señalados aquí contacte con el Soporte tecnico Eliwell o consulte nuestra web www.eliwell.it

APPLICATION
Mensaje error Panel Efecto Solución

Comunicación target no conectado Verifica las configuraciones 
del puerto COM

utilizando el menú 
desplegable 

Communication > Settings
EWDMi Properties

icono ComServer
no visible en la barra de 

aplicaciones

Comunicación target no conectado

Desconecte el hardware de 
comunicación (Ejemplo DMi, 

convertidor USB/485 etc)
Nota.

Desconecte antes el lado 
target y luego el lado PC.

invalid memory image file.
Please upload memory 
image from the target

Output error de compilación
conectar el dispositivo target 
FREE Smart mediante DMi 

al PC

DEvICE
Mensaje error Panel Efecto Solución

invalid connection string Connection Status target no conectado

Verifica las configuraciones
de comunicación 

utilizando el menú 
Communication > Settings

EWDMi Properties
o

modificando la secuencia el 
menú 

Communication > Advanced

SIMuLATION

Mensaje error Panel Efecto Solución

no target definition for 
simulator (tgSx) found
Unable to run simulator

- Simulation no se ejecuta

desde el panel 
Project > Select target

seleccione el target correcto
entre los disponibles y 
confirme con Change

http://www.eliwell.it
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En tabla se muestran algunas de las combinaciones de teclas disponibles (Shortcuts) para activar/desactivar las principales 
funciones de Application. Para Device ver tabla siguiente y/o columna de Notas.
Connection y user Interface disponen de atajos para abrir, guardar y compilar proyectos
El funcionamiento ‘toggle’ indica que la función se activa si estaba desactivada y, lo contrario, se desactiva si estaba activa, 
utilizando la misma combinación de teclas.
Por ej. CtRl+U activa el Full Screen, es decir pantalla completa: pulsando CtRl+U de nuevo la desactivamos[1]

la Ayuda En linea se activa con la tecla F1

Menú Función Función Atajos Notas

Todos AYuDA EN LINEA hELP F1
Siempre Disponible
hELP imprimible en 

formato PDF

APPLICATION ShORTCuTS 

Menú Función Función Atajos Notas

Edit imprimir Print CtRl+P ***

Edit Cortar Cut CtRl+x ***

Edit Copiar Copy CtRl+C ***

Edit Pegar Paste CtRl+V ***

Edit guardar Save CtRl+S ***

View > toolbars
Pantalla completa Full Screen CtRl+U toggle***

View > toolbars
barra herramientas lenguaje iEC

FBD
FBD BAR CtRl+D toggle

View > toolbars
barra herramientas lenguaje iEC 

lD
lD BAR CtRl+A toggle 

View > toolbars
barra herramientas lenguaje iEC 

SFC
SFC BAR CtRl+q toggle

View > toolbars barra herramientas proyecto PROjECt BAR CtRl+j toggle

View > toolbars barra herramientas red NEtWORK CtRl+M toggle

View > toolbars barra herramientas documento DOCUMENt BAR CtRl+N toggle

View > tool Windows visualiza panel proyecto WORKSPACE CtRl+W toggle

View > tool Windows visualiza panel mensajes OUtPUt CtRl+R toggle***

View > tool Windows visualiza panel librería liBRARy CtRl+l toggle

View > tool Windows visualiza panel ventana watch WAtCH WiNDOW CtRl+t toggle***

View > tool Windows visualiza panel osciloscopio
ASyNC gRAPHiC 

WiNDOW
CtRl+K toggle***

PROjECt compilación proyecto COMPilE F7
en el caso de más 
proyectos compila 

solo el seleccionado

COMMUNiCAtiON descarga código a la aplicación DOWNlOAD CODE F5

DEBUg
añade una variable al panel 

watch
ADD SyMBOl tO 

WAtCH
F8

cuando la variable 
está seleccionada 

(no vale drag & drop)

DEBUg
añade una variable al panel 

watch
iNSERtS NEW itEMS 

iNtO WAtCH
SHiFt + F8

seleccionado de un 
listado

1 en Device la visualización de los paneles  es definida desde el menú view spuntando o no las singole voci

ShORTCuTS
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Menú Función Función Atajos Notas

DEBUg
ADD SyMBOl tO A 
DEBUg WiNDOW

F10

DEBUg
iNSERtS NEW itEMS 

iNtO A DEBUg 
WiNDOW

SHiFt + F10

DEBUg
ADD/REMOVE 
BREAK POiNt

F12

DEBUg
ADD/REMOVE 
tExt tRiggER

F9

DEBUg
ADD/REMOVE 

gRAPHiC tRiggER
SHiFt + F9

DEBUg REMOVE All tRiggERS
CtRl+SHiFt + 

F9

DEBUg trigger list CtRl+i

*** valido también para Device

DEvICE ShORTCuTS

Menú Función Función Atajos Notas

Edit imprimir Print CtRl+P ***

Edit Cortar Cut CtRl+x ***

Edit Copiar Copy CtRl+C ***

Edit Pegar Paste CtRl+V ***

View > toolbars
Pantalla completa Full Screen CtRl+U toggle***

View > tool Windows visualiza panel mensajes OUtPUt CtRl+R toggle***

View > tool Windows visualiza panel ventana watch WAtCH WiNDOW CtRl+t toggle***

View > tool Windows visualiza panel osciloscopio
ASyNC gRAPHiC 

WiNDOW
CtRl+K toggle***

PARAMEtERS lee los parámetros seleccionados READ SElECtED CtRl+SHiFt+R los parámetros 
seleccionados se 

destacan en amarilloPARAMEtERS
escribe los parámetros 

seleccionados
WRitE SElECtED CtRl+SHiFt+R

PARAMEtERS selecciona todos los parámetros SElECt All CtRl+A

Operación a efectuar 
con cautela

la operación 
siguiente podría 
escribir todos los 
parámetros y/o 

restaurar los valores 
por defecto

*** valido también para Application
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Evolution

uSER INTERFACE ShORTCuTS

Menú Función Función Atajos Notas

CONFigURAtOR BAR nuevo proyecto NEW PROjECt CtRl+N ***

CONFigURAtOR BAR apertura proyecto OPEN PROjECt CtRl+O ***

CONFigURAtOR BAR compilación proyecto HMi
gENERAtE CODE

(COMPilE)
F7

*** valido también para Connection

CONNECTION ShORTCuTS

Menú Función Función Atajos Notas

MAiN BAR nuevo proyecto NEW PROjECt CtRl+N ***

MAiN BAR apertura proyecto OPEN PROjECt CtRl+O ***

MAiN BAR Salva Save CtRl+S

*** valido también para user Interface
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APÉNDICE - EjEMPLO DESARROLLO PROYECTOS

PROYECTO 1 - CONTADOR

A continuación le mostraremos el procedimiento para escribir, testar y descargar en el FREE Smart un sencillo programa 
COUNtER escrito en lenguaje St que realiza un cómputo y visualiza en el osciloscopio un ‘diente de sierra’.

El programa COUNtER realiza el cómputo de la variable local a de 0 a MAxSCAlE1. Cuando a llega a MAxSCAlE1 se reinicia-
liza a -100.

Como se ha descrito anteriomente en el capítulo Primer Arranque,  
• arranque Application, 
• cree un nuevo proyecto CONTATORE
• cree un programa COuNTER en lenguaje ST

En la sección central Edit escriba el código del programa COuNTER en lenguaje ST.

Programa COuNTER

if a>=MAXSCALE1 then

a:=-100;

else

a:=a+1;

end_if;

b:=a*10;

count:=a;

counter1:=b;

variables locales
En la sección variables creamos las variables a y b (utilice el menú desplegable variables > Insert, o el icono Insert record) 
locales de tipo DiNt, asociando como valor inicial (Init value) 0 (cero)
las variables a y b no son útiles fuera del programa COUNtER por lo que se las define como locales.

variables y constantes globales
En el programa hemos definido además una constante que definiremos de modo ‘global’:
• la constante MAxSCAlE1 se crea en el panel Project >Global  variables Costants que crearemos aquí del mismo modo 

que se ha creado una variable local. MAxSCAlE1 tiene un valor por defecto de -100 por lo que no es necesario definirla 
como variable sino como constante.

variables ‘compartidas’ (Global Shared)
Como deseamos visualizar el resultado del contador del target en el programa hemos definido además 1 variable que defini-
remos como ‘Global shared’[1]:
la variable count, que crearemos, se obtiene en el panel Resources>Modbus Objects > Status variables y no de la sección 
Edit/Variables, introduciendo un nuevo registro.
En este caso tendremos que definir también como aparecerá el nombre de la variable en el display de 7-segmentos de FREE Smart 
(es decir etiqueta de 4 dígitos máximo, por ejemplo CNT para count) y el mapeado entre Application Type y Device Type

En el programa COUNtER hemos definido otra variable counter1[2] que definiremos del mismo modo. 
En este caso no definimos como aparece en el display. El software propondrá por defecto COun (en lugar de COUnter) es 
decir utilizará las primeras 4 letras que se visualizarán en el display de 4-segmentos.

1 Téngase en cuenta que la carpeta 'Global shared' aparece si y solo si definimos la variable en la pestaña Resources>Modbus Objects > Status variables

2 Téngase en cuenta que si hubiésemos creado una variable counter y no counter1 en fase de compilación habríamos tenido un error  
 (conflicto de nombre entre programa COuNTER y variable)
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visualización principal
Haciendo click en Resources>FREE Smart elegimos qué deseamos mostrar en el display como visualización principal[3]

Elegimos la variable count (que, recordemos, es el valor de la variable local 'a')
Actualizamos el programa introduciendo una alarma como siempre activa o siempre desactivada.

if allarme then

allarme1:=FALSE;

else

allarme1:=TRUE;

end_if;

la variable de alarma (allarme) se ha de definir como variable local - de tipo BOOl (booleano). 
Por defecto se propone FALSE como valor inicial - para modificarlo basta escribir TRuE. 
la alarma estará siempre activa. Podemos introducir una descripción del tipo 'Alarm always active' es decir alarma siempre 
activa.
Allarme1 se define en el Panel Resources>Alarms. Como etiqueta introducimos AlM1

Creación Menú
A este punto llegados podemos crear: 
• el menú personalizado PRg1 para introducir posibles parámetros definidos por el desarrollador (o utilizar los existentes de 

BiOS)
• el menú personalizado SEt1 para introducir las 2 variables count y counter1

Task
Volviendo a la pestaña Project situándose sobre el task timed añadimos el programa COUNtER.

Compilación
Compilamos el proyecto - menú desplegable Project >Compile (o F7)
Nota: el proyecto es compilado sin errores y sin la necesidad de utilizar un FREE Smart conectado al PC

recapitulando...
... veamos las pantallas

Programa COuNTER - Project tab Programa COuNTER - Resources tab
visualización principal

Programa COuNTER - Resources tab
definición variables Locales

3 Como se puede ver la selección comprende las I/O por defecto + las variables creadas dicho fin por el desarrollador
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Programa COuNTER - Resources tab
menú Set (SET1)

Programa COuNTER - Resources tab
menú Alarms (Alarmas)

Programa COuNTER - Resources tab
definición variables Global Shared

Note
en la pestaña Project las variables compartidas (global shared) aparecen solo después de haberlas dado de alta en la pestaña 
Resources. En el ejemplo:
• Alarms  allarme1
• Parameters PAR1
• Variables  count y counter1

Conexión a FREE Smart y descarga de aplicación
tras haber conectado FREE Smart a la DMi y al PC en el puerto USB y haber efectuado las debidas comprobaciones en la COM 
y el baudrate (ver correspondiente capítulo) nos podemos conectar al dispositivo target:
• con el menú desplegable Communication > Connect o icono Connects to the target conéctese a FREE Smart
• si la conexión se ha realizado con éxito aparecerá el mensaje en verde CONNECtED abajo a la derecha[4]

• ahora desde el menú desplegable Communication > Download code (F5) o icono Code download descargue la aplica-
ción al  FREE Smart

• una o varias ventanas[5] de diálogo aparecerán para indicar que se está descargando la aplicación. la descarga podría 
requerir algunos segundos

aplicación IEC existente sobre el target
confirmar que sigue

PLC para resetear
confirmar cambio

descarga de la aplicación en curso

Ahora la aplicación debería funcionar en el FREE Smart

4 En caso contrario ver capítulo Download on target o troubleshooting
5 Dependiendo de si el target ya ha sido programado o no
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watch y Osciloscopio

En el display del target aparece el valor de count[6] que va de -100 a +100.
téngase en cuenta que aparece el lED de alarma en cuanto se activa la alarma.
En el menú de Estados se puede comprobar la presencia 
• de la carpeta SEt1 con las variables CNt y COUNt
• de la carpeta Al con la alarma AlM1 a 1

En Application se puede teste  ar el valor de las variables y visualizarlas en modo texto o gráfico simplemente arrastrando la 
variable del código al panel watch y Oscilloscope
Véase la siguiente pantalla

• Véase como las variables locales a y b van en ciclos de -100  a 100 (x 10 para la variable b) y las correspondientes variables 
count y counter1 del mismo modo.

• "Allarme" es una variable boolena siempre verdadera (tRUE indicado en rojo[7]) y allarme1 vale 1
• la variable count se visualiza en el osciloscopio y se ve el 'diente de sierra'

Guardando proyecto
El proyecto se puede guardar como counter.ppjs o con un nombre a elegir, generar un fichero .rsm, proteger con contraseña y 
exportar como objeto de librería (.pll)

DEvICE

El proyecto se puede abrir con Device:
Se abrirá la herramienta del mismo nombre, donde podrá leer o escribir uno o varios parámetros de BiOS, modificarlos y/o 
descargar nuevamente el por defecto. 
Se puede leer el valor actual de las variables definidas por el desarrollador pero no modificarlas.

Device no supone que el usuario tenga que saber ningún lenguaje de programación, el código fuente no es visible.  
Device supone que nos tengamos que conectar de nuevo al dispositivo target (haga click en su correspondiente icono). El pa-
nel central muestra las referencias del protocolo, dirección etc. El nombre del dispositivo target es por defecto FREESmart_1[8].
Cuando el dispositivo target se conecta se pueden leer los parámetros o escribir los parámetros por defecto o los modificados.
6 Count se configura como visualización fundamental. Si no se selecciona ninguna variable aparece el mensaje PLC.
 Pulsando F5 se visualiza FREE y se puede acceder a las variables y parámetros de BIOS
7 Modificando "Allarme" de TRuE a FALSE, recompilando y descargando la nueva aplicación el LED de alarma se apaga y la variable se indicará  
 en verde en el panel watch
8 Con un simple copiar-pegar se puede crear un proyecto gemelo FREESmart_2, modificar los parámetros de BIOS y descargarlos en el target o  
 en un segundo target
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Lectura parámetros 

Supongamos que desea leer todos los parámetros (Read all device parameters)

Como se ve hay parámetros de configuración que tienen valores por defecto distintos de los presentes en el target (resaltados 
en azul)

visualización variables 
tal como sucede en Application , también en Device se pueden visualizar las variables simplemente arrastrándolas sobre los 
paneles Watch y Oscilloscope.

Escritura de parámetros 

Supongamos que deseamos descargar todos y solo los parámetros Cl (BiOS locales). 
Seleccione todos los parámetros - menú desplegable Parameters>Select all (CtRl+A) o mediante el correspondiente 
icono . los parámetros aparecen todos resaltados en amarillo.  Escribir menú desplegable Parameters>write selected 
(CtRl+SHiFt+W) (o mediante icono w)
todos los parámetros Cl se cargarán en el target.

 

carpeta CF
parámetros CF31 y ui26 con valores 
por defecto distintos de la aplicación

watch / Oscilloscope
variables count y counter1

descarga parámetros CL (todos) en 
curso

El proyecto se puede guardar como Counter.CFN o con el nombre que elija.
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PROYECTO 2 - CONTADOR2 FuNCTION BLOCk

Partiendo del programa COUNtER descrito en el ejemplo anterior creamos un bloque de función y modificamos la aplicación 
iEC añadiendo código para la conmutación de un lED / relé

Guardado proyecto

guardamos el proyecto COUNtER renombrándolo como COUNtER2:
En el menú desplegable File>Save project as el sistema propone la carpeta de trabajo COUNtER.
Suba un nivel, cree una nueva carpeta COUNtER2 y guarde el proyecto como COUNtER2.

Creación bloque de función (function block)

Crear un nuevo bloque de función COuNTERST en lenguaje ST.
Copiar/pegar el programa COUNtER en el panel Edit del bloque de función con algunas variantes.

Programa (Bloque de función) COuNTERST 

if a>MAX then

a:=-100;

elsif enable then

a:=a+1;

end_if;

out:=a;

variables locales, de entrada y de salida
En la sección B[1] variables creamos las variables:
• a como variable local
• MAX y enable como variables de entrada al bloque de función
• out como variable de salida al bloque de función
El bloque de función tendrá por tanto 2 variables de entrada, una variable de salida y una variable local que memorizará el 
estado del contador en cada instancia del bloque de función.

1 ver capítulo Definición Paneles Application
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Escribimos ahora el programa COUNtER2 donde se realizará la llamada del bloque de función.
El bloque de función tendrá 2 instancias CounterSt1, CounterSt2 definidas como variables locales de tipo  CounterSt

Mientras estamos escribiendo el código téngase en cuenta que Application guía al desarrollador en la escritura del código 
proponendo las variables a pasar al bloque de función[2] 

la variable booleana en este caso servirá para conmutar 
• un relé debidamente configurado 
• un lED[3] del target en función de una condición definida

Ahora escribimos el nuevo código COUNtER2

Programa COuNTER2
CounterSt1(enable:=not Enable_Counter1,MAX:=MAXSCALE1);
counter1:=CounterSt1.out;

CounterSt2(enable:=Enable_Counter2,MAX:=MAXSCALE1/2);
counter2:=CounterSt2.out;

allarme:=(counter1>counter2);

if allarme then

allarme1:=TRUE;
Alarm_relay := TRUE;

else

allarme1:=FALSE;
Alarm_relay := FALSE;

end_if;

if (counter1<=counter2) then
 sysLocalLeds[6]:=1;
else
 sysLocalLeds[6]:=0; 
end_if; 

2 En el ejemplo 2 de entrada (identificadas por un icono con las flechas a izquierda, y la salida con las flechas a la derecha)

3 Explotamos la target variable sysLocalLeds. ver correspondiente sección
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En la pestaña Resources han de crearse y/o ser renombrados del proyecto anterior
los parámetros de EEPROM, variables de estado etc
Además, si se desea, se han de añadir los recursos al menú Prg y menú set

En el menú I/O mapping se pueden asociar los recursos a las entradas/salidas
Asociamos a una entrada digital Enable_Counter1 y a una salida Alarm_relay

El programa ahora está completo.

Exportación al dispositivo target
le aconsejamos que desde el menú desplegable Developer>Export application to catalog exporte el proyecto al catálogo 
para permitir que Device pueda volverlo a utilizar para su descarga al dispositivo target

Antes de la exportación al catálogo es necesario desde el menú desplegable Project>Options proporcionar al proyecto una 
release (ej. el mismo nombre counter2), una versión (ej. 1.0) y recompilar el proyecto 

Esto permitirá que Device reconozca la aplicación iEC presente en el target cuando se descargue.

Compile el proyecto y descárguelo al target mediante Application o Device

El contador mostrará en el display un cómputo de -100 a 100 de modo análogo a como sucede en la aplicación iEC COUNtER 
descrita anteriormente.
En este caso el lED Alarma conmutará el lED del compresor[4] una vez se alcanze el umbral definido.

4 SysLocalLeds[6], IL LED alarma es SysLocalLeds[16]
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